Boris Title Toolkit User Guide Version 1.0

The material contained herein is protected by copyrights. Permission to use materials may be granted upon written request and proper credit.

Contact information
Boris FX, Inc.
381 Congress Street
Boston, MA 02210
Phone: (617) 451-9900
Fax: (617) 451-9916
E-mail: info@artelsoft.com
http://www.borisfx.com

For information on site licenses, please call (617) 451-9900 or e-mail sitelicense@artelsoft.com

For technical support
Visit the Boris FX Technical Forum at http://www.borisfx.com/support. You can also contact technical support by calling (617) 451-9900 or e-mailing techsupport@artelsoft.com.

The information in this guide is believed to be accurate and reliable. However, Boris FX, Inc. assumes no responsibility for its use; nor for any infringements of patents or other rights of third parties which may result from its use. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form, by any means, electronic, mechanical, by photocopying, recording or otherwise without the prior written permission of Boris FX, Inc.

Boris Title Toolkit™ and PixelChooser™ are trademarks of Boris FX. After Effects® is a registered trademark of Adobe® Systems Incorporated.

Written by Catherine Adams, Jeanine Brennan and Anne Renehan.

Copyright © 2003 by Boris FX, Inc. All rights reserved. Printed in the U. S. A.

Updated May 2003.
Overview

Boris Title Toolkit 1.0 includes four After Effects filters, Vector Text, Title Crawl, Vector Shape and Text Scrambler.

Contacting Technical Support

For technical support, visit the Boris FX Technical Forum at: http://www.borisfx.com/support.

You can also contact technical support by calling (617) 451-9900 or e-mailing techsupport@borisfx.com.

Supported Hosts

Boris Title Toolkit version 1.0 supports version 5.5 or later of Adobe® After Effects® running on both Windows and Macintosh systems.

Visiting the Boris FX Website

The Boris FX website provides the latest news as well as updates on Boris products. Visit www.BorisFX.com.

Installing Boris Title Toolkit

Download the Boris Title Toolkit installer from the download page on the Boris FX website.

Make sure to enter your correct email address on the download page so that we can email you a free installer serial number which you need to enter into the installer.

The installer will place demo versions of the Boris Title Toolkit filters inside your After Effects Plug-Ins folder. These filters are fully functional for a 14-day evaluation period. After the trial period expires, the product will function as a demo and will render with an “X” through the effect.

Purchasing Boris Title Toolkit

To purchase a full version of the Boris Title Toolkit after downloading the evaluation version, click either the Purchase or Learn More button on the bottom of the Demo Application window. This window appears the first time the Text window opens in each Toolkit filter in an AE session.

You will need to copy the Unique Product ID number found at the bottom of the Demo Application window. Enter this Unique Product ID number when you visit the Boris online store to purchase Boris Title Toolkit.
Clicking the Purchase or Learn More button opens the Boris online store in your default web browser. Follow the onscreen instructions and enter your information into the store pages in order to receive your Unlock Code by email.

Copy the unique product ID number found here to the web store to receive your Unlock Code.

Title Toolkit Evaluation

Thank you for evaluating the Boris Title Toolkit. The Toolkit is fully functional during the fourteen day evaluation period. After the trial period expires, the Toolkit will function in demo mode until an unlock code is entered.

You can purchase an unlock code online at anytime during or after the trial period by clicking the Purchase button below, or by visiting www.borisfx.com/buyit/toolkit/. Click Learn More to visit www.borisfx.com to learn more about this product.

9 days remain in the Toolkit evaluation.

Please use the following unique product ID number when purchasing the Boris Title Toolkit:

3M84743-CGRF88A-5333F43-583A463

Click the Purchase and Learn More buttons to view product demos and buy the full version.

Click the Unlock button to display the Registration window. Enter the Unlock Code emailed to you.

You must enter your correct email address when purchasing so that we can email you the Unlock Code. You need to enter this code into the Registration window.
After you receive your Unlock Code, launch After Effects and click **Unlock** in the Demo Application window. Enter your Name, Company Name and Unlock Code into the boxes in the Registration window and click **OK**.

Now your Boris Title Toolkit is fully registered.
Working in Adobe After Effects

This section provides information on using Boris Title Toolkit in the After Effects user interface.

Applying Boris Filters

When the Boris Title Toolkit filters are installed in the After Effect's plug-ins folder, they automatically appear in the Effect menu with the other After Effects filters. The Boris Title Toolkit filters appear under the Boris category. To apply a Boris filter, simply select a layer in the timeline and choose the appropriate filter from the Boris category in the Effect menu.

Working with Parameter Groups

Each Title Toolkit filter has a number of parameter controls which are categorized into groups. Groups of parameters appear under a text header set off by underlines (for example, “_Path_”). The illustration below includes five parameter groups. The Type On group has been expanded, revealing the parameters within.

Clicking the disclosure triangle to the left of a text header expands the parameter group, revealing its contents. Click the triangle a second time to close the group.
Working with Layer Menus and Precomposing

Layer menus enable you to use information from other layers in your composition to control some aspect of the filter applied to the source layer. The Layer menu includes choices corresponding to each layer in the composition, in addition to a None setting. For example, you can map a layer in your composition to the face of your text. When None is selected, the menu has no affect on the filter.

It is important to note that the filter uses the chosen layer’s source media without any effects and/or geometric transformations that were applied to the layer in the composition. If you would like to transform the chosen layer and have the transformations affect the source layer, you need to complete the following steps to precompose.

1. Place the source media in a second composition and apply the desired effects and/or transformations.
2. Drag the second composition into the original composition.
3. If you already applied effects and geometrics to a layer, you can use the Precompose command (in the Layer menu) to move the layer and its effects into a new composition.
4. Choose the composition from the Layer menu.

Menu choices cannot be animated.

Working with Point Controls

Point controls specify locations along the X and Y axis in the source image. If the effect is selected in the Effect Controls window, the Comp window includes a position point icon for each point control parameter.

There are several different ways to enter and edit point control values:

- Click the cross-hair and click the mouse at the desired location in the Comp window.
- Click the cross-hair, adjust the location with the arrow keys, and press Return or Enter.
- Click the numerical values and enter new values in the dialog box.
- Select the appropriate effect in the Effect Controls window, and drag the position point corresponding to the point control that you want to adjust.
Working with Color Controls
Color controls are used to choose a color for some attribute, such as a shadow border, or text face. Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen.

Hiding a Filter
In the Effect Controls or Timeline window, select the layer, and then click the Effect option to the left of the effect name.

Resetting a Filter
To reset a filter, press Reset at the top of the filter controls in the Effect Controls window.

Using AE Expressions
You can add expressions to parameters in Boris Title Toolkit filters to create relationships with properties in other Toolkit filters, or with properties in native AE filters.

For example, you create text using the Vector Text filter and a backdrop using the Vector Shape filter. You then animate the text. You can use an expression to make sure the backdrop also follows the same animation. For detailed information on creating expressions, see the After Effects documentation.

For a tutorial on using expressions, see “Exercise 5: Using Expressions to Animate Text and a Backdrop” on page 109.
Understanding the Boris Text Filters

Boris Title Toolkit includes four After Effects filters, Vector Text, Title Crawl, Vector Shape and Text Scrambler.

Vector Text offers vector-based text that can be manipulated in 3D Space with full pivot control, animated tracking and other text transformations. For more information on vectors, see “Understanding Vector Graphics and Bitmaps” on page 13. Once you set the characteristics of the individual text characters, you can animate the text.

Title Crawl allows you to easily animate a text page. The Title Crawl effect automatically keyframes the text tracks to roll or crawl across the screen. The text page is automatically aligned and animated so that you do not have to set keyframes in the timeline.

Vector Shape allows you to create simple vector shapes to use as backdrops behind text. You can use one of the supplied shapes or create your own using the After Effects Pen tool. The backdrops can include texture maps, borders and shadows.

Text Scrambler provides a way to generate random text or numbers. You can lock each letter or number in position regardless of changes made to neighboring characters. A typical example would be a timecode or numerical countdown.

Text effects can be manipulated on two levels. The controls in the Text window affect text on a character basis, allowing you to assign different styles, colors, drop shadows, borders, and fill to individual characters. These controls are only available in the Text window and cannot be animated. In addition, the Style Palette can be used to create and save styles settings for future use.

Once you set the characteristics of the individual characters, you can use the Effect Controls window to animate the text. Move and rotate text in 3D space, create a text on a path or type on effect, and animate motion blur, lights, and shadows. These features are animated by setting keyframes in the timeline. You can also create auto-animated rolls and crawls.

Creating a Text Effect

Select a layer in the After Effects timeline and choose Vector Text, Title Crawl, Text Scrambler or Vector Shape from the Boris category in the Effects menu.

Editing Text

Once you create a text page, you can edit the text at any time by clicking the Text Scrambler, Title Crawl, Vector Text or Vector Shape banner in the Effect Controls window. This opens your text in the Text window where you can make changes. Clicking the Options button also opens the Text window.
Understanding the Boris Text Controls

The following controls appear in the Text window for each of the four filters.

Working with Sliders

Drag the slider controls to adjust the value of the parameter. You can also scrub the numerical field.

Some parameters allow values higher than the range of the slider, which you can enter into the numerical field that accompanies the parameter, then press Return (Macintosh) or Enter (Windows). If you enter a number that exceeds the possible value range, a dialog box displays the minimum and maximum values for the parameter.

Working with Dial Controls

Dial controls are used for parameters whose values are measured in degrees, such as angles or hue values. Drag the needle around the dial to adjust the value.

Working with Color Controls

Color controls are used to choose a color for an attribute of an object, such as a shadow, border, or text face. Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen. Some color controls also allow you to enter RGB values into the numerical fields and then press Return (Macintosh) or Enter (Windows).

Drag the eyedropper across the color ramp to quickly choose a color. Click the color ramp to toggle it to a grayscale image.

You can preview a color in the Text window before committing to it. Click the eyedropper and drag over the color ramp. Press C to preview the color in the Comp window. You can preview as many colors as you want. Press V to commit to the previewed color, or press Return (Macintosh) or Enter (Windows). To cancel and leave the color unchanged, press Escape.

Until you commit to the color by pressing V, or pressing Return (Macintosh) or Enter (Windows), the color is not applied even though it appears in the Color chip.
Understanding Vector Graphics and Bitmaps

A **bitmap image** is an image represented by a grid of pixels, each of which is assigned a specific color. This produces a coherent image when viewed at the intended size, but if scaled dramatically the pixels become apparent and the image loses quality.

The example at right shows the letter P represented as a bitmap. A video image is an example of a bitmap, as is an image produced in an application such as Photoshop.

A **vector graphic** is a resolution-independent image mathematically represented as a series of lines and curves called vectors. The relationship between the vectors remains constant as the object is scaled, so there is never a loss of quality.

The example at right shows the letter P composed of vectors. An EPS file is an example of a vector graphic.

The titles that you create are vector-based. This means that they remain razor sharp even if you scale them very large.

**Advantages of Vector Graphics**

You should use vector graphics when you need to preserve the vectors in a file to scale the object. For example, if you have a very small logo and need to make it larger.

This image shows an original EPS file used as a mask. When the EPS file is converted to a bitmap, and the mask is scaled, the edges become pixelated and lose quality. Built-in antialiasing compensates for this degradation somewhat by smoothing the jagged edges, but can cause the image to blur.

When vectors are used, the mask can be scaled and no quality is lost, because the shape uses the vector information in the media file.
Working with the Text Window

The parameters in the Text window allow you to create, import, and edit text media for inclusion in your titling effect. The Text window provides control over the font, size, color, and spacing of each individual character and allows you to add shadows. In addition, the Style Palette can be used to create and save styles settings for future use.

The controls in the Text window are not animateable. For example, if you want to apply a static shadow to text, you would do this in the Shadow tab in the Text window. However, if you want to animate the shadow’s color and position, you would not apply the shadow in the Text window. Instead, create text without a shadow in the Text window and apply the shadow using the Effect Controls window.

The upper portion of the Text window is the text preview area. You can type text in this area, then select one or more characters to make style changes using the Style, Page, Fill, Border, and Shadow tabs. These tabs are explained in the following sections.
Selecting Text

You can select text in the Text window just as you can in most word processing programs. Press Command-A (Macintosh) or Control-A (Windows) to select all text in the preview area. You can also double-click to select a word or triple-click to select an entire paragraph.

When you select text in the Text window, the characters invert. This is called active selection. Active selection means that keyboard actions are directed at the selected text. When you type new characters, they overwrite the actively selected text. The example at right shows white text that is actively selected in the Text window.

When you see an outline around the selected text, this is called passive selection. Passive selection means that keyboard actions are directed at the parameters in the lower portion of the Text window. When you type characters, they will not overwrite the passively selected text; they affect the numerical field for a parameter (such as Style Opacity). To passively select text, select the text then simply click in the numerical entry area for any parameter in the lower portion of the Text window.

Working with Tabs and Rulers

The text preview area is bordered by rulers to help you precisely position your text. To create a tab, click anywhere on the horizontal ruler and drag to position the new tab. Double-click the tab marker to change the tab from Left justified to Right or Center justified. To remove a tab, drag it down away from the ruler.

The white region indicates the boundaries of the page determined by Page Width and the Margin controls. The gray regions indicate the margins determined by the Margin controls.

The Page Width and the Margin controls are described in “Working with the Page Tab” on page 22.

Resetting Text Styles

To reset parameters in the selected text, click the Reset Style button. Any parameter changes that you made in any of the Text window’s tabs are reset to the default. You must select the text that you want to reset. To reset all the text, press Command-A before clicking the Reset Style button.

Reset Style does not reset the Tracking, Kerning, Leading, Justification, and Page Size parameters nor does it remove any tabs that you created. Reset Style only affects settings that can be saved as styles in the Style Palette.
Applying Text Styles

To use styles from the Style Palette, click the Style Palette button. The Style Palette includes preset text styles and allows you to save and categorize styles for future use. For more information, see “Working with the Style Palette” on page 36.

Importing Text Files

To import a Simple Text file or a Rich Text Format file, click the Import File button. This opens a dialog box which allows you to navigate to a text file to import. All style settings in the original file are retained when imported into the Text window.

Previewing Text

The Style Preview menu sets which styles display in the preview area. Choose All Styles to preview the text as it will appear in the Comp window.

When Basic Styles is selected, shadows, borders, and some text transformations applied in the Style tab (Style Skew, Style Scale, Style Baseline) do not display in the preview area. Basic Styles reduces preview time and does not affect the image in the Comp window.

When Draft Typing is selected, shadows, borders, and some text transformations applied in the Style tab do not display in the preview area while you type. Once you finish typing, the text updates with all styles. Draft Typing reduces preview time while you type, but still allows you to preview text as it will appear in the Comp window.

Scale sets the size of the text in the preview window to a percentage of its actual size. Use smaller percentages to work with large bodies of text or to speed previews.

Updating Text

Click the Cancel button to exit without saving any changes you made in the Text window.

Click the Apply button to exit the Text window and save your changes.
Working with the Style Tab

The Style tab controls allow you to set the font, size, and style of the text, in addition to the tracking, leading and kerning of the characters.

Use the **Font menu** to choose a font from the list of fonts available on your system. Then set the font size using the **Size menu** or typing a custom font size and pressing Return (Macintosh) or Enter (Windows). The font size menu retains the three most recently used font sizes.

Use the **Font buttons** to browse through the list of available fonts. The button on the left moves to the previous font in the list; the button on the right moves to the next font in the list. All fonts installed in your system appear in the list. You can also view thumbnails of all fonts on your system in the Style Palette. For more information, see “Creating Font Styles” on page 39.

The **Size buttons** scale the size of all fonts in the selected text by integers of 10. This is useful if your text contains multiple font sizes and you want to scale all sizes up or down equally. The size buttons let you scale without changing the size of each individual character or selection.

The **Fixed Width checkbox** forces the selected text spacing to remain the same distance apart, even when the letters change. In general you should use this checkbox only when working with numbers or with letters using mono spaced fonts. If you select this checkbox with letters that are not mono spaced, you may need to manually kern them to make the spacing appear even.

The **Style buttons** allow you to apply styles to selected characters. Select the characters you want to change, then click one of the buttons. Click again to remove the style. The available styles are, from left to right, **Normal, Bold, Italic, Underline, Superscript**, and **Subscript**.

Certain styles (such as Italic) do not work if the selected font does not include these styles. This is particularly true of symbol, dingbat, and Kanji fonts.
Justifying Text

To align text horizontally, click a **Justification button**. You can choose **Left**, **Center**, or **Right** justification. The text is justified in relation to the page width and height that you set. This parameter affects the text globally, regardless of which characters are currently selected.

The Justification buttons in the second row force the text to justify to both margins when you work with more than one line of text. **Flush Left Justification** forces all lines of text to justify and left justifies the last line. **Force Center Justification** forces all lines of text to justify. **Flush Right Justification** forces all lines of text to justify and right justifies the last line.
Tracking adjusts the spacing, in pixels, between the characters in the Text window. This parameter affects the text globally, regardless of which characters are currently selected. Like all parameters in the Text window, Tracking is not animatable. If you want to create an animated tracking effect, you should use the Tracking parameter in the Effect Controls window.

Kerning adjusts the spacing, in pixels, between the selected group of characters in the Text window without affecting the text globally. Some applications refer to this as pair kerning. To adjust the kerning, select the characters and drag the slider. You can also press the Option (Macintosh) or Alt (Windows) key and the Left or Right Arrow keys to adjust this setting in increments of 1.

Leading adjusts the spacing, in pixels, between multiple lines of text. This parameter affects the currently selected lines.

Style Skew X and Style Skew Y distort the selected character(s) along the horizontal and vertical axis, respectively.
**Style Hue** provides an easy way to affect the color value of all the style elements with a single parameter. To adjust a complex text style, you might have to adjust the colors on five or six separate parameters. Instead, Style Hue shifts the hue of all color values in the text style an equal amount. This parameter also provides an easy way to save multiple versions of a text style so that each variation varies in hue.

Style Hue is a downstream process in relation to the other color parameters in the Text window. It doesn’t change the individual values of the parameters it affects, but rather it acts as a filter affecting the final appearance of the overall text style. In other words, if you use Style Hue to hue shift blue text with a yellow border 180 degrees, the text will now appear yellow with a blue border. However, if you look at the individual parameters, the Fill still displays as set to Blue and the Border parameter still displays as set to yellow.

When you start to build a new text style, if Style Hue is not set to zero, it can appear that color parameter manipulations made to individual parameters don’t match the text appearance. Leave Style Hue set to zero when designing text styles, and then perform the Hue shift as a final step to avoid confusion.

If a text style element doesn’t have any color (if it is black, white, or gray), it is not affected by the Style Hue parameter. If a text style has very little color, the affect may be quite subtle. Additionally, the Style Hue parameter only affects color parameters adjusted within the Text window (not the color parameters adjusted in the AE Effect Controls window).

**Style Hue adjustments with animated jitter parameters**

![Vector text](image1.png)  
*Style Hue = 90 degrees*  
![Vector text](image2.png)  
*Style Hue = 130 degrees*  
![Vector text](image3.png)  
*Style Hue = 180 degrees*
**Style Baseline** adjusts the vertical position of the selected character(s) in relation to the baseline of the text. Decrease this value to move the bottom of the character below the baseline, or increase this value to raise the character above the baseline.

![Style Baseline adjustments with the “EX” in “TEXT” selected](image)

- **Style Baseline** = -100
- **Style Baseline** = 0
- **Style Baseline** = 100

**Style Scale X** and **Style Scale Y** set the scale of the selected character(s) along the horizontal and vertical axis, respectively.

![Scale Y adjustments with the “EX” in “TEXT” selected](image)

- **Style Scale Y** = 50
- **Style Scale Y** = 100
- **Style Scale Y** = 200
Working with the Page Tab

The Page tab controls allow you to adjust the margins and to set the size of the text page.

Text Wrap controls the position of the text when the text is wider than the screen.

- **No Wrap** creates an unbroken line of text, allowing you to use the text as a continuous crawl.
- **Wrap** creates additional lines of text if the text exceeds the chosen **Page Width** value. As a word passes the limit of the Page Width, it moves to the next line. Wrap is on by default and affects the justification setting. For example, if you choose Left Justification with **Wrap**, the text is left justified within the specified Page Width. The Page Width option appears in the tab when you choose Wrap.

When **Top down Text** is selected, the text reads vertically, from top to bottom.

Selecting **Right to Left** creates text that reads from right to left, instead of left to right.

The **Top Margin**, **Left Margin**, **Bottom Margin**, and **Right Margin** controls determine the width, in pixels, of the four respective margins.
**Working with the Fill Tab**

The Fill tab options allow you to set the fill and opacity of the text.

The parameters in the Fill tab are not animatable. To animate the text fill, use the Style parameters in the Effect Controls window. For information, see "Working with the Fill Parameter Group" on page 58.

Select the **Fill On** checkbox to turn on the fill. Deselect this option to create transparent text.

**Style Opacity** adjusts the opacity of the selected character(s). A setting of 100 makes the text completely opaque, while a setting of 0 makes the text completely transparent.

The **Text Fill menu** determines what type of media is applied to the face of the text.

- Choose **Color** to use the selected **Style Color**. Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen. You can also enter RGB values into the numerical fields associated with the color control and press Return (Macintosh) or Enter (Windows).
- Choose **Gradient** to map a gradient to your text. When you choose Gradient, click the **Gradient Editor icon** that appears in the tab. The Gradient Editor opens. Adjust the gradient and click **OK** to apply it. If you select the **Live Update checkbox**, the Text window updates automatically as you make changes in the Gradient Editor. Gradients are described in the following section.

When you apply a gradient in the Text window, the gradient is centered on each individual letter. You can also apply a gradient or other media to the text as a texture map, using the controls in the Effect Controls window. When you do this, the gradient is centered behind all the text.
Working with Gradient Fills

A gradient is a graduated blending of two or more colors. The Boris Text filters let you map gradients to text. You can use the Gradient Editor to set the colors and transparency levels in the gradient, the shape and direction of the gradient, and the gradient’s steepness—that is, how quickly each color changes to the next color.

To access the Gradient Editor, in the Fill tab in the Text window, choose Gradient as the Text Fill and click the Gradient Editor icon.

The Gradient Editor adjusts the locations of the start and end colors in the gradient. The start and end colors are represented by the color stops. Each color stop sets the point at which the gradient reaches a pure color. Each pair of color stops has a midpoint between them, which indicates the point at which the start and end color are equally blended.
Adding and Deleting Color Stops

A gradient can include up to sixteen color stops. You can add color stops by clicking in the area directly below the gradient editor. The new color stop is assigned the color of the point on the gradient editor above the stop, and a midpoint automatically appears between the new color stop and each neighboring color stop. Color stops are numbered in the order that you create them. If you remove a color stop, the remaining color stops do not renumber. To delete a color stop, drag it downward away from the gradient editor.

Selecting Color Stops and Midpoints

Click any color stop or midpoint to select it. When a color stop is selected, its point turns black. An unselected color stop has a clear point. A color stop must be selected to apply changes to it.

Setting the Location of Color Stops and Midpoints

You can drag color stops and midpoints to different locations in the gradient. As you drag a color stop, its Position updates. This value is expressed as a percentage—a value of 100 represents the right edge of the gradient, and a value of 0 represents the left edge of the gradient. For a midpoint, the Midpoint percentage indicates the midpoint’s position between two color stops. Instead of dragging, you can enter a Midpoint or Position to move a color stop or midpoint to the desired location.
Adjusting Color and Alpha Values
To adjust the color and alpha value of a color stop, select the color stop you want to change, then use the Selected Color Stop controls to choose the color and transparency level you want.

Color sets the color of the selected stop. Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen. You can also enter RGB values into the numerical fields and then press Return (Macintosh) or Enter (Windows).

The Color Ramp lets you quickly pick a color using the eyedropper. Click the color ramp before you select the eyedropper if you want to toggle the ramp to a grayscale image.

Alpha sets the transparency of the selected stop. At the default value of 0, the gradient is totally opaque. At 255, the gradient is fully transparent. Intermediate values produce varying degrees of transparency.

Setting the Shape and Direction of the Gradient
The remaining controls determine the shape and direction of the gradient.

Choose Linear, Radial, Contour, Bevel, Edge or Revolve from the Type menu to choose the shape of the gradient. Each gradient has its own controls which are described in the following sections.
The **Repeat Stops** parameter allows you to repeat the gradient pattern. This parameter is common to all Gradient Types. The following example shows the Repeat Stops parameter using a Linear Gradient Type.

**Linear Gradient Type**

A *Linear* gradient places the start color at the left and blends toward the end color at the right.

_Angle_ adjusts the direction in which the colors blend across the screen when using a linear gradient.
Radial Gradient

A Radial gradient places the start color at the center and blends outward toward the end color.

Center X determines the location of the gradient center on the X axis. This value scales as a percentage in which 0 represents the left edge of the frame, 50 represents the middle, and 100 represents the right edge of the frame. Negative values move the center out of the image frame on the left side. Values above 100 move the center out of the frame on the right.

Center Y determines the location of the gradient center on the Y axis. This value scales as a percentage in which 0 represents the top edge of the frame, 50 represents the middle of the frame, and 100 represents the bottom edge of the frame. Negative values move the center above the image frame. Values above 100 move the center below the image frame.

Contour Gradient Type

A Contour gradient places the start color along all four edges of the frame and blends inward toward the end color in the center of the frame.
Fade determines the width of the gradient between the start and end colors. This value is measured as a percentage of the size of the image.

**Bevel Gradient Type**

A *Bevel* gradient creates a beveled pyramid effect in which the four colors of the sides of the pyramid move from the start to the end color.

**Angle** controls the color of each beveled side by setting the location of the start color on the beveled sides. For example, at a value of 0, the start color is placed on the right bevel and the end color on left bevel. As the Angle increases, the start color is placed “between” the right and bottom bevels. Consequently, the right bevel color is increasingly affected by the middle color as the start color moves towards the bottom bevel. At a value of 90, the start color is placed on the bottom bevel, and so on.
**Edge Gradient Type**

The *Edge* gradient shape combines the contour and a bevel shapes. This creates a beveled pyramid effect in which the four colors of the sides of the pyramid move from the start to the end color and blend inward toward the middle color in the center of the frame.

**Fade** sets the width of the gradient between the edge colors (controlled by **Angle**) and the middle color at the center of the frame. This value is measured as a percentage of the size of the image.

![Fade = 25](image1)

![Fade = 75](image2)

**Angle** controls the color of each beveled edge by setting the location of the start color on the beveled edge. For example, a value of 0 places the start color on the right edge and the end color on the left edge. As the **Angle** increases, the start color is placed “between” the right and bottom edges. Consequently, the right edge color is increasingly affected by the middle color as the start color moves towards the bottom edge. At a value of 90, the start color is placed on the bottom edge, and so on.

![Angle = 10](image3)

![Angle = 80](image4)
Revolve Gradient Type
A Revolve gradient shape emanates from a center point.

Center X and Center Y determine the location of the center when using a Revolve gradient.

Center X sets the location of the gradient center on the X axis. This value is scaled as a percentage in which 0 represents the left edge of the frame, 50 represents the middle of the frame, and 100 represents the right edge. Negative values move the center out of the image frame on the left side. Values above 100 move the center out of the frame on the right side.

Center Y sets the location of the gradient center on the Y axis. This value is scaled as a percentage in which 0 represents the top edge of the frame, 50 represents the middle of the frame, and 100 represents the bottom edge. Negative values move the center above the image frame. Values above 100 move the center below the image frame.

Angle sets the direction that the colors blend across the screen when using a Revolve gradient.

Saving and Loading Gradients
To save a gradient, click the Save button. A dialog box allows you to name the file and choose the location in which to save it. Then click Save in the dialog box.

To load a previously saved gradient, click the Load button in the Color Stops tab. A dialog box allows you to navigate to the gradient’s location. Then click Open in the dialog box.

You can also save a gradient to the Style Palette. For more information, see “Creating and Saving Styles” on page 38.
Working with the Border Tab

The Border tab allows you to apply up to five different border styles to the edges of the text. The parameters in this tab can be used to create beveled or glowing text effects.

The parameters in the Border tab are not animatable. To animate the border, use the Edges parameters in the Effect Controls window. For information, see “Working with the Edges and Shadows Parameter Group” on page 54.

Click one of the numbered Border Style tabs to create a new border style. Select the checkbox next to the tab to apply the appropriate style.

Each tab offers the following controls.

- **Position** sets the location of the border.
  - *Inside* positions the border on the inside of the edges of the selected character(s).
  - *Outside* positions the border on the outside of the edges of the selected character(s).
  - *Center* centers the border over the edges of the selected character(s), so half of the border is on the inside of the text edges and half is on the outside.

- **Edge Color** sets the color of the border for the selected character(s). Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen. You can also enter RGB values into the numerical fields associated with the color control and press Return (Macintosh) or Enter (Windows).

- **Edge Width** sets the width, in pixels, of the border applied to each selected character.

- **Edge Opacity** adjusts the opacity of the border for selected character(s). A setting of 100 makes the border completely opaque, while a setting of 0 makes the border completely transparent.
**Edge Style** controls the style of the border. Each style has its own controls, which are described in the following sections.

*Plain* applies a flat border to the text.

When Plain is selected, **Edge Softness** softens the edge of the border. A value of 0 creates a border with a hard edge, and raising this value increasingly softens the border.

![Text example with Plain style](image1)

*Bevel* creates a beveled border effect.

When Bevel is selected, **Highlight Color** sets the color of the lightest parts of the bevel.

**Shade Color** sets the color of the darkest parts of the bevel.

**Highlight Angle** sets the angle between the highlights and the horizontal axis.

![Text example with Bevel style](image2)

*Radial* creates a soft glowing border effect.

When Radial is selected, **Outside Color** sets the color of the soft edges of the border.

**Radial Fade** controls the opacity of the outer edge of the border. When Radial Fade is 0, the outer edge is opaque. Higher Radial Fade values increase the transparency of the edge, and at a value of 100, the outer edge is transparent.

**Edge Softness** softens the edges of the border. A value of 0 creates a border with a hard edge, and raising this value increasingly softens the border.

![Text example with Radial style](image3)
Working with the Shadow Tab

The Shadow tab applies up to five different shadows to the selected text. Like the other parameters in the Text window, the Shadow tab parameters cannot be animated. If you want to animate text shadows, create text without shadows in the Text window. Then use the Shadow parameters in the Effect Controls window. For more information, see “Working with the Edges and Shadows Parameter Group” on page 54.

Click one of the numbered Shadow Style tabs to create a new shadow style. Select the checkbox next to the tab to apply the appropriate style to the selected text.

Each tab offers the following controls.

Shadow Type determines what type of shadows are created.

- **Drop Shadow** falls a specified distance from the object.
- **Cast Shadow** appears to fall on another object; therefore the appearance and shape of this type of shadow depends on the distance between the two objects, and the shape of the object on which the shadow falls.
- **Solid Shadow** simulates the appearance of a 3D object by applying a gradient to a shadow. Solid shadows are useful if you want to create text with a three dimensional appearance but do not need to apply transformations that would reveal that the text is actually 2D. For example, you could create a static title using 2D text with solid shadows.
The following example includes both a solid shadow and a drop shadow. The solid shadow looks most realistic if the Highlight Color and Shade Color are similar to the text fill color.

Shadow Color sets the color of the shadow. Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen. You can also enter RGB values into the numerical fields associated with the color control and press Return (Macintosh) or Enter (Windows).

Shadow Distance sets the distance between the shadow and the text. Use a small value to offset the text slightly; use a larger value to create distinct shadows that appear to fall on another surface.

Shadow Opacity sets the degree of opacity. A value of 100 makes the shadow completely opaque. Lowering this value makes the shadow increasingly transparent. A value of 0 creates a completely transparent shadow.

Shadow Softness softens the edges of the shadows, emulating the appearance of shadows cast by a diffuse light source. A value of 0 creates shadows with hard edges. Increasing this value softens the shadow edges.

Shadow Angle sets the angle between the shadow and the horizontal axis of the text. Drag the needle around the dial or type a number into the numerical field and press Return (Macintosh) or Enter (Windows).

When the Shadow Type menu is set to Solid Shadow, Highlight Color sets the color of the highlighted areas of the shadow, and Shade Color sets the color of the shaded areas of the shadow.

Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen. You can also enter RGB values into the numerical fields associated with the color control and press Return (Macintosh) or Enter (Windows).
Working with the Style Palette

The Style Palette allows you to save and categorize styles for text, fonts, color, and gradients for future use. The styles are organized into tabs. Each tab in the Style Palette also includes a collection of preset styles.

Style Control Buttons

- **Toggle Thumbnail Background** displays the style over a checkerboard or a solid black color.
- **Thumbnail View** resizes the thumbnails or displays them in List view.
- **Save Gradient Style to Disk** opens a dialog box that lets you save the selected gradient style.
- **Delete Style** deletes the selected style from the Style Palette.
• **Add Style** adds a style to the Style Palette.
• **Rename Style** opens a dialog box where you can name your style.
• **Edit Style** lets you edit the selected style.
• **Apply Style** applies the selected style.

**Opening the Style Palette**

To open the Style palette, click the **Style Palette button** in the Text window.

**Categorizing Styles**

Use the **Add Category button** to create categories to organize your styles. For example, to use a group of styles in one project, create a category for that project. The Style Palette must include at least one category for you to create new styles.

To create a new category, click the **Add Category button**. A dialog box allows you to name the category. The new category name appears in the category menu. When you choose a category from the menu, all styles associated with that category appear in the right side of the Style Palette. Any new styles you add are saved to the currently selected category.

Categories are not shared between tabs—each tab contains only the categories created in that tab. For example, if you create a category in the Text tab, then select the Color tab, the text category does not appear in the Color tab's category menu.

You can rebuild the current category, by clicking the **Rebuild Category button**. For example, if you created a category using a checkerboard background and you want to switch to a black background, click this button.

**Selecting the Thumbnail View**

You can view styles in Frame or List View. In List View, you can arrange styles by name or date using the **Thumbnail View button** and the **Sort By menu**. In Frame View, you can resize the thumbnail images.

1. Click the **Thumbnail View button** and choose the appropriate view from the menu, **Small Frame View**, **Medium Frame View**, **Large Frame View** or **List View**.
2. If you choose List View, choose the appropriate sort criteria, **Date** or **Name**, from the **Sort By menu**.
3. Click the **Toggle Thumbnail Background button** to toggle between a black background and a checkerboard. The checkerboard is useful if your style is very dark. For example black text is easier to see over the checkerboard.
Creating and Saving Styles

The procedure for creating and saving styles depend on the type of style you are creating.

Creating Text Styles

1. Use the parameters in the Text window to adjust the style as desired.
2. In the Text window, select the text that you want to save as a style.
3. Click the **Style Palette button** to open the Style Palette and select the Text tab.
4. Click to select the appropriate **Apply checkboxes**. The Apply controls select attributes of the current style to save as a new style. For example, save the current style’s Font and Border only. When you add the style, only these attributes are included.
5. Choose the category where you want to save the style. See “Categorizing Styles” on page 37 for more information.
6. In the Text tab in the Style Palette, click the **Add Style button**. The current style in the Text window is added to the selected category in the Style Palette.
7. Name the style. For more information, see “Naming and Deleting Styles” on page 40.

Creating Color Styles

1. In the Text window, click the **Style Palette button** to open the Style Palette and select the Color tab.
2. Choose the category where you want to save the style. See “Categorizing Styles” on page 37 for more information.
3. In the Style Palette, click the **Add Style button** in the Color tab.
   A new black color style is added to the selected category. The color style is named “New Color.”
4. Click to select the new black color style’s thumbnail and click the **Edit Selected Style button**. The Color Picker opens to let you edit the new color style. Click OK when you finish editing the color.
5. Name the style. See “Naming and Deleting Styles” on page 40.

Creating Gradient Styles

1. In the Text window, click the **Style Palette button** and select the Gradient tab.
2. Choose the category where you want to save the style. See “Categorizing Styles” on page 37 for information.
3. Click the Add Style button. The Gradient Editor opens to let you create a custom gradient. When you finish, click OK.

4. Name the style. For information, see “Naming and Deleting Styles” on page 40.

Creating Font Styles

The Style Palette lets you save thumbnails of all the available fonts on your system in the Fonts tab. The first time you launch this tab you have to add a category. After that you only need to rebuild the category if you add more fonts to your system. Unlike the other tabs in the Style Palette, you cannot save styles to the Font tab, so the Apply controls as well as the Add Style and Rename Style buttons do not appear when you are in the Font tab.

1. Open the Text window and click the Style Palette button.

2. In the Fonts tab in the Style Palette, click the Add Category button. A dialog box allows you to name the category. The new category name appears in the category menu.

3. If this is the first time you have used the Font tab or if you have added new fonts to your system, click the Rebuild Category button. The software will scan the system’s font folder. When it finishes, the Font tab displays all the available fonts on your system.

Depending on the number of fonts you have, it may take a while to scan the font folder. The system may pause for a few seconds at the end while the Style Palette builds the font thumbnails.
Naming and Deleting Styles

To delete a style, select the style’s thumbnail and click the Delete Style button. The style’s thumbnail is deleted from the Style Palette.

To rename a style, select the style’s thumbnail and click the Rename Style button. A dialog box appears. Type a name and click OK. You can also rename a style by selecting the style, pressing Return (Macintosh) or Enter (Windows), typing a name and pressing Return or Enter again. You can also delete and rename styles using contextual menus. For information, see “Using Contextual Menus in the Style Palette” on page 40.

Applying Styles

The procedure for applying styles depend on the type of style you are applying.

1. In the Text window, select the appropriate text. Select individual characters or press Command-A (Macintosh) or Control-A (Windows) to select all text.

2. Click the Style Palette button at the bottom of the Text window. In the Text tab in the Style Palette, click to select the appropriate parameters to apply. The choices are Fonts, Size, Face, Fill, Edge, Shadow and Transform.

3. Double-click the thumbnail for the style you want to apply or click to select the thumbnail and click the Apply Style button.

Note for Windows Users: If you apply a Text Style from the Style Palette and want to undo it, make sure that the Text window is highlighted when you undo, rather than the Style Palette.

Using Contextual Menus in the Style Palette

You can use contextual menus in the Style Palette to apply, rename, and delete styles. You can also view information about a particular style.

1. Press the Control key and select a setting in the Style Palette (Macintosh) or Right-click a file (Windows) to open its contextual menu.

2. Choose the appropriate menu item.
   - **Apply** applies the style to the selected object
   - **Rename** lets you rename the style in the Style Palette.
   - **Delete** removes the style from the Style Palette.
   - **Properties** opens a dialog box with information about the style. When you finish, click OK to close the dialog box.
Working with the Vector Text Filter

Vector Text offers vector-based text that can be manipulated in 3D Space with full pivot control, animated tracking and other text transformations including text on a path, jitter and type on effects. Once you set the characteristics of the individual text characters in the Text window, you can animate the text. Unlike the parameters in the Text window, the Effect Controls window parameters apply to the text globally.

When the Continuously Rasterize checkbox is selected, the vector form of the text is forced to recalculate based on Page Transformations parameter changes. While this is useful for specific types of effects, it is unnecessary for many effects and can slow performance - most noticeably when using sophisticated text styles. Select the Continuously Rasterize checkbox to improve image quality in the following situations.

- When the Scale parameters is set to scale the text much larger than 100% size.
- When using large negative Position Z values.
- When the Tumble or Spin parameters are set so that parts of the text appear very close to the viewer.
- When Rotating text with a bevel or emboss style and you want the highlight to recalculate accordingly.

When using the Continuously Rasterize option, set up the effect with the option disabled to improved preview performance. Then select the option as a final step to improve the render.

You do not need to select the Continuously Rasterize checkbox for any Transformations other than Page Transformations. The Vector form of the text is always recalculated for any scaling, rotating or repositioning of text characters in the Letter Transformations, Path, Type On, Jitter, Edges and Shadow, Fill and Motion Blur parameter groups.
When the **Composite on Original** checkbox is selected, the filter composites the text over the source layer, which remains visible behind the text. When this checkbox is deselected, the text is composited over an alpha channel. Layers in the timeline that are below the filtered layer are visible in the Comp window.

**Working with the Page Transformations Parameter Group**

**Opacity** sets the opacity of the text, and is scaled as a percentage. At a value of 100, the text is completely opaque. Lower Opacity values make the background image visible through the text. At a value of 0, the text is completely invisible.

**Position X/Y** set the coordinates of the text’s center point. Adjust Position X/Y to reposition the text. If the text is rotated using the Tumble, Spin or Rotate parameters, **Position X/Y** positions the rotated text.

**Position Z** adjusts the apparent depth of the text. Decreasing negative values move the text closer to the viewer, while increasing positive values move the text farther away. Very low Position Z values move the text behind the viewer, making it invisible. If the text is rotated using the Tumble, Spin or Rotate parameters, **Position Z** positions the rotated text.

**Master Scale** lets you adjust Scale parameters globally. Parameters can still be changed independent of one another by using the individual Scale parameters. For example, you set Scale X to 100 and Scale Y to 200 to create text that is stretched vertically. If you then set Master Scale to 200, the resulting text is twice as wide and four times as tall as the original.

**Scale X** and **Scale Y** change the size of the object along the X and Y axes, respectively. These parameters are scaled as percentages of the object’s original width or height. Thus, a Scale X setting of 200 produces text twice as wide as the original text.

**Tumble, Spin, and Rotate** change the text’s perspective along the X, Y, and Z axes respectively. Tumble, Spin, and Rotate can be animated over values greater than 360° in order to make the shape complete more than one full revolution.

Normally, these controls rotate the text around its center, but you can also set an external pivot point around which to tumble, spin, or rotate text.
If you rotated your text using the Tumble, Spin or Rotate parameters, **PreRotate Position X/Y** positions the text ignoring any of these transformations and uses the original coordinates of the plane. This parameter can show a different result than adjusting the Position X/Y parameter which positions the text after any rotations are applied to it.

If you rotated your text using the Tumble, Spin or Rotate parameters, **PreRotate Position Z** positions the text ignoring any of these transformations and uses the original coordinates of the plane. This parameter can show a different result than adjusting the Position Z parameter which positions the text after any rotations are applied.

It is useful to remember that the pivot point remains at the actual X, Y, or Z position even when you change the PreRotate parameters. For example if you alter a PreRotate parameter and then spin the image, the image will spin around the pivot point at its original position and not the PreRotated position.

In the example below where the words “Vector Text” are rotated by using the Spin and Tumble parameters, the lighter arrows show the positioning of the text using the PreRotate Position X and Y parameters. The darker arrows show the positioning of the text with the Position X, Y and Z parameters. (Position Z would point right at you).

![Example Image](image)

When the **Lock Pivot to Position** checkbox is selected, the text revolves around its center point. Deselect this option to sets the coordinates around which the text revolves using the **Pivot X/Y** and **Pivot Z** parameters.

**Pivot X/Y** and **Pivot Z** determine the coordinates of a point around which the text revolves when you tumble, spin, or rotate it.
Working with the Letter Transformations Parameter Group

**Tracking** controls the global horizontal spacing of the characters in the effect. Unlike the Tracking parameter in the Text window, you can animate this Tracking parameter.

![Tracking examples](image)

**Leading** adjusts the spacing, in pixels, between multiple lines of text. This parameter affects the currently selected lines. Unlike the Leading parameter in the Text window, you can animate this Leading parameter.

**Baseline** adjusts the vertical position of the text in relation to the baseline. Decrease this value to move the bottom of the text below the baseline, or increase this value to raise the character above the baseline. Unlike the Baseline parameter in the Text window, you can animate this Baseline parameter.

**Letter Skew X** and **Letter Skew Y** distort text along the horizontal and vertical axis.

![Letter Skew examples](image)

**Master Letter Scale** lets you adjust Letter Scale parameters globally. Parameters can still be changed independent of one another by using the individual parameters. For example, you set Letter Scale X to 100 and Letter Scale Y to 200 to create text that is stretched vertically. If you then set Master Letter Scale to 200, the resulting text is twice as wide and four times as tall as the original.

Selecting the **Lock Letter Scale** checkbox locks the scale of the text along the horizontal and vertical axis. When you adjust one of the parameters, the other automatically updates to maintain the aspect ratio.
Letter Scale X and Letter Scale Y set the scale of the text along the horizontal and vertical axis. These parameters differ from the Page Transformations parameter group’s Scale X and Scale Y parameters, which scale the entire text layer. For example, if you set Scale X to 200, the resulting text would be stretched twice as wide as the original. If you set Letter Scale X to 200, the resulting text would be stretched twice as wide as the original but the characters would overlap since Letter Scale affects each letter. This is useful for creating animated tracking or type on effects.

Letter Tumble, Letter Spin, and Letter Rotate rotate the text characters around their baseline’s X, Y, and Z axis, respectively. Compare how this appears with the Page Transformations parameter group’s Tumble, Spin and Rotate parameters which move the entire text layer around the axis. For more information, see page 42.

![Letter Tumble](image1.png) ![Letter Spin](image2.png) ![Letter Rotate](image3.png)

Working with the Path Parameter Group

The Path parameters allow you to create text on a path.

The Path Type menu lets you choose the type of path.

- **AE Path** allows you to use a path that you create in After Effects by creating a new mask with the AE Pen tool. Once you create the path, choose it from the Text Path menu.
- **Circle** allows you to create a circular path by setting the Point 1 and Point 2 parameters. Point 1 sets the center point of the circular path. Point 2 sets the radius of the circle.
- **Line** allows you to create a linear path by setting the Point 1 and Point 2 parameters.

![Text on an AE Path](image4.png) ![Text on a Circle Path](image5.png)
On Path Motion adjusts the position of the text on the path. You can animate over values greater than 360° to make the text complete more than one full revolution.

On Path Motion animated from 0 to 1 Degrees

Angle to Path allows you to control how text is positioned on the path. When Angle to Path is at the default value of 100, the Text position follows the curve of the path. As Angle to Path values approach 0, the text becomes more vertical on the path, regardless of the path’s curve.

The Alignment menu allows you to set the justification of text on path. This creates a much wider range of design possibilities. This means that you can create settings with centered text that won’t require adjustment if the length of the text changes. The Alignment menu includes the following choices.

- **Left** aligns the text so that each line starts at the beginning of the path. This is the default.
- **Center** centers the text on the length of the path.
- **Right** aligns the text so the end of the line matches the end of the path.
- **Distribute** justifies the text along the length of the path.

Select the **Reverse Path checkbox** to map the text to the underside or inside of the path.
Path Jitter X and Path Jitter Y vary the position of the text on the path along the X and Y axis, respectively. Higher values produce more jitter, and increase the amount that the position varies from frame to frame.

Path Jitter Velocity allows you to control the speed of the Path Jitter X and Path Jitter Y parameters.

Path Jitter Seed varies the amount of Jitter from frame to frame.

Working with the Type On Parameter Group

The Type On parameter group offers several options for creating animated writing or “type-on” effects.

Text Type On adjusts the percentage of the text that is visible in each frame, allowing you to create animated typing effects. This value is measured as a percentage of the complete text. For example, if Text Type On is set to 50, the first half of the text is visible. If Text Type On is 100, all the text is visible. Text Type On is animatable; the other parameters in this group are applied progressively to each individual character as it types on.

Type-on effect with Text Type On animated from 0 to 100.

Type On Order menu allows you to control the order in which the text types on. The Type On Order menu includes the following options:

• Forward types on the text from left to right.
• Reverse allows you to reverse the effect so that the text types on starting from the left.
• Random types the text type on randomly.

Type On Order=Forward.
Press the **Apply To menu** and choose the appropriate option.

- **Letter** applies the effect to individual letters and characters.
- **Word** applies the effect to individual words. Words are defined as characters that are separated by a space in the Text window.
- **Line** applies the effect to individual lines. Lines are defined as characters that are separated by a carriage return in the Text window.

Click the **Always Visible checkbox** to force all text characters to remain visible. This Type On feature applies transformations progressively to text characters. When this checkbox is deselected, characters progressively appear or disappear from the frame. Selecting the Always Visible checkbox forces characters to remain visible while the transformations are progressively applied. One way to think of this effect is like “the wave” that crowds perform at football stadiums; the transformation appear to pass through the text. The animatable Type On parameter behaves as the center of the wave when this checkbox is enabled.
Reveal Time controls how long each character animates during the effect. This parameter only affects animations created with the Fade, Shift, Skew, Tumble, Spin, and/or Rotate parameters (described below). For example, you create a four second type-on effect with the word “Text.” If Text Type On is animated from 0 to 100, each letter in the word Text animates onscreen for one second. Reveal Time specifies the percentage of that one second that the Fade, Shift, Skew, Tumble, Spin, and/or Rotate lasts. Thus if Reveal Time is 50, each character Fades, Shifts, Skews, Tumbles, Spins, and/or Rotates for 0.5 seconds (50% of 1), and subsequently remains stationary for the rest of the effect. In this case, the next letter does not appear for another 0.5 seconds after the previous letter stops animating.

Acceleration allows you to gradually accelerate the effect.

Overshoot allows you to create bouncing text effects, when combined with any parameters except Fade. Each character moves past its destination position or scale by the value specified in Overshoot before returning to its destination position or scale. This parameter only affects animations created with the Shift, Scale, Skew, Tumble, Spin, and/or Rotate parameters. If all of these parameters are set to the default, Overshoot has no affect.

Decay works in conjunction with the Overshoot parameter. Decay is expressed as a percentage that allows you to exponentially decrease the Overshoot. For example, you set the Shift Y so that the characters move in from the top of the frame with an Overshoot of 300. Setting Decay to 50 means that each of the three bounces will decay by half.
Fade allows you to gradually fade in successive characters. When Fade is set to 100, each character appears suddenly and is fully opaque. Decreasing this value creates a more gradual effect, in which each character fades on as its opacity increases.

Shift X and Shift Y adjust the starting position of the characters in relation to their destinations (controlled by the Position X/Y and Position Z values in the Page Transformations parameter group) on the screen. For example, if the text is placed in the center of the screen and Shift X is set to 320, when Text Type On is animated, each character first appears on the right side of the screen, then moves toward the center.

Type-on effect with Shift X set to 320.

Scale X and Scale Y adjust the starting size of the characters. The default value is 100, in which the text types on the screen full size. If you decrease the value, the text appears to grow on the screen as it types.

Skew X and Skew Y set the starting Skew values for the characters in relation to their final skew values (controlled by the Skew X and Skew Y values set in the Text window and in the Letter Transformations parameter group). Each character animates from its starting Skew values to its ending Skew values as it appears on screen.

Type-on effect with Skew X set to 180.
Tumble, Spin, and Rotate set the starting Tumble, Spin, and Rotate values for the characters in relation to their final Tumble, Spin, and Rotate values (controlled by the Letter Tumble, Letter Spin, and Letter Rotate values set in the Letter Transformations parameter group and by the Tumble, Spin, and Rotate controls in the Page Transformation parameter group). Each character animates from its starting Tumble, Spin, and Rotate values to its ending values as it appears on screen.

Type-on effect with Rotate set to 180.

Jitter Position randomizes the position of the individual text characters on the X and Y axis.

Jitter Rotate randomizes the angle of the individual text characters. Jitter Rotate distorts text on the X and Y axes, respectively.

Jitter Scale randomizes the scale of the individual text characters.
Working with the Jitter Parameter Group

The Jitter parameter group allows you to randomize text parameters including Position, Angle, Scale, Hue and Opacity. The Jitter parameters are expressed as a percentage and are applied to individual text characters. All parameters have a range of 0 to 100, except for Scale which has a range of 0 to 600.

The Jitter parameters are similar to the Jitter parameters in the Type On parameter group. When you apply the Jitter parameters in the Type On parameter group, they apply progressively to each character as it types on. When you apply these parameters in the Jitter parameter group, they are applied to all characters. When you set values for these parameters in both the Type On and Jitter parameter groups, the parameters in the Type On parameter group are applied to individual characters until the character is typed on; the parameters in the Jitter tab are applied after each character is typed on.

Vector Text parameter effect with Jitter animated

Jitter Seed varies the amount of Jitter from frame to frame.

Jitter Speed varies the speed of the Jitter.

Jitter Position X and Jitter Position Y randomize the position of individual text characters on the X and Y axis respectively.

Jitter Angle randomizes the angle of the individual text characters. Angle distorts text on the X and Y axis.

Jitter Scale X and Jitter Scale Y randomize the scale of the individual text characters on the X and Y axis respectively.

Jitter Hue randomizes the color of the individual text characters. Hue sets the color fill of the text. If a text doesn’t have any color (if it is black, white, or gray), its color is not affected by the Jitter Hue parameter. If a text has very little color, the affect may be quite subtle.

Jitter Opacity randomizes the transparency of the individual text characters.
The **Restrictions menu** lets you restrict the Jitter parameters. For example, you can restrict the Jitter Scale X and Y parameters so that they only scale larger than the original text.

- **None** does not restrict the parameters.
- **Positive Only** restricts the parameters so that the values can only be higher than the original parameter.
- **Negative Only** restricts the parameters so that the values can only be lower than the original parameter.

**Polarize** lets you alternate the Jitter parameters for characters. At more extreme values, every other character will alternate.

**Master Jitter Amount** scales the Jitter parameters globally. Parameters can still be changed independent of one another.
Working with the Edges and Shadows Parameter Group

The Edges and Shadows parameter group options allow you to create and animate the borders of the text, and apply one of three types of animatable shadows to the text.

The parameters in the Edges and Shadows parameter group apply to all characters in the Text track and are animatable. To apply different borders or shadows to individual character, use the Border or Shadow parameters in the Text window. For information, see “Working with the Border Tab” on page 32 and “Working with the Shadow Tab” on page 34.

Edge Parameters

The Edge Type menu controls the style of the border. Each style, Plain, Bevel and Radial, has its own controls, which are described later in this section. The following controls are common to all three edge types.

The Edge Position menu sets the location of the border.

- **Inside** positions the border on the inside of the edges of the selected character(s).
- **Outside** positions the border on the outside of the edges of the selected character(s).
- **Center** centers the border over the edges of the selected character(s), so half of the border is on the inside of the text edges, and half on the outside.

Edge Color sets the color of the border for the selected character(s). Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen.

Edge Width sets the width, in pixels, of the border applied to each selected character.

Edge Opacity adjusts the opacity of the border for selected character(s). A setting of 100 makes the border completely opaque, while a setting of 0 makes the border completely transparent.

Border Begin and Border End adjust the percentage of the border that is visible at each frame in the timeline, allowing you to create animated border effects. These values are measured as a percentage of the complete border. For example, if Border Begin is set to 0 and Border End is set to 50, the first half of the border is visible. If Border Begin is set to 50 and Border End to 100, the second half of the border is visible.

Text Border effect with Stroke End animated from 0 to 100.
Use the **Border Offset** dial in conjunction with Border Begin and Border End to select a portion of the border and animate it around the text.

Text Border effect with Border Offset animated from 0 to 2 degrees

**Edge Softness** softens the edge of the border. A value of 0 creates a border with a hard edge, and raising this value increasingly softens the border.

The **Edge Cap and Join menu** determines the shape of the ends and corners of the border. Choose from the following options.

- **Flat/Miter** draws flat ends and corners with sharp points.
- **Flat/Round** draws flat ends and rounded corners.
- **Flat/Bevel** draws flat ends and clipped corners.
- **Round/Miter** adds a circular cap to the ends and draws corners with sharp points.
- **Round/Round** adds a circular cap to the ends and draws rounded corners.
- **Round/Bevel** adds a circular cap to the ends and draws clipped corners.
The Edge Type menu controls the style of the border. Each style has its own controls, in addition to the controls described above:

**Plain Parameters**
Choosing Plain from the Edge Type menu applies a flat border to the text.

**Bevel Parameters**
Choosing Bevel from the Edge Type menu creates a beveled border effect.

When Bevel is selected, Edge Highlight Color sets the color of the lightest parts of the bevel.

Edge Shade Color sets the color of the darkest parts of the bevel.

Edge Highlight Angle sets the angle between the highlights and the horizontal axis.

**Radial Parameters**
Choosing Radial from the Edge Type menu creates a glowing border effect.

When Radial is selected, Edge Outside Color sets the color of the soft edges of the border.

Edge Radial Fade controls the opacity of the outer edge of the border. When Edge Radial Fade is 0, the outer edge is opaque. Higher Edge Radial Fade values increase the transparency of the edge, and at a value of 100, the outer edge is transparent.
Shadow Parameters

The Shadow Type menu determines what type of shadows are created.

- **None** does not apply a shadow.
- **Drop shadow** fall a specified distance from the object.
- **Cast shadow** appear to fall on another object; therefore the appearance and shape of this type of shadow depends on the distance between the two objects, and the shape of the object on which the shadow falls.
- **Solid shadow** simulate the appearance of a 3D object by applying a gradient to a shadow. Solid shadows are useful if you want to create text with a three dimensional appearance but do not need to apply transformations that would reveal that the text is actually 2D.

**Shadow Color** sets the color of the shadow. Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen. You can also apply colors from the Style Palette. For more information, see “Working with the Style Palette” on page 36.

**Shadow Distance** sets the distance between the shadow and the text. Use a small value to offset the text slightly; use a larger value to create distinct shadows that appear to fall on another surface.

**Shadow Opacity** sets the degree of opacity. A value of 100 makes the shadow completely opaque. Lowering this value makes the shadow increasingly transparent. A value of 0 creates a completely transparent shadow.

**Shadow Softness** softens the edges of the shadows, emulating the appearance of shadows cast by a diffuse light source. A value of 0 creates shadows with hard edges. Increasing this value softens the shadow edges.

**Shadow Angle** sets the angle between the shadow and the horizontal axis of the text.

When the Shadow Type menu is set to **Solid Shadow**, **Highlight Color** sets the color of the highlighted areas of the shadow, and **Shade Color** sets the color of the shaded areas. Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen. These parameters have no affect with any other shadow type.
Working with the Fill Parameter Group

The Fill parameter group options allow you to set the fill and opacity of the text, as well as map media onto text. Instead of applying a static fill in the Text window, you can use these parameters to fill text with an animatable color that applies to all characters. To apply different fill to individual character, use the Fill parameters in the Text window. For information, see “Working with the Fill Tab” on page 23.

The Fill menu allows you to choose whether to set the fill in the Text Window or using the Fill parameters.

- Choose From Text Window to set the fill in the Text window. When you select this, the rest of the fill parameters in the Fill parameter group will be dimmed.
- Choose Override Text Window to set the Fill Color, Fill Opacity and Texture Map Layer using the Fill parameters. Set the appropriate Fill Color by clicking the color chip to access the system color picker or using the eyedropper to choose a color from the screen. Fill Opacity sets the opacity of the text fill, and is scaled as a percentage. At a value of 100, the fill is completely opaque. Lower Opacity values make the background image visible through the text. At a value of 0, the fill is completely invisible. When this option is deselected, the text uses the Fill that was set in the Text window.

The Map Method menu controls how the media maps onto the text. The following example shows a still image of a large flower as a texture.

- Choosing Tile repeats the texture image on the face of the text. When you choose Tile, decrease the Tile Size X and Tile Size Y parameters to better see the tiled image within the text.
- Choosing Stretch sizes the texture image to fit the text. Stretch can distort the image, depending on its aspect ratio.
- Choosing Clip allows you to independently size and position the texture image on the text. When you choose Clip, Scale X and Scale Y change the size of the texture image along the X and Y axis respectively.
Offset X and Offset Y move the center of the Texture image along the X and Y axis respectively. This repositions the texture within the text. These parameters are dimmed when you choose Stretch as the Map Method.

**Working with the Motion Blur Parameter Group**

Enabling or disabling Motion Blur is not global to the effect. Motion Blur can be keyframed and enabled for only portions of the effect. This allows you to save processor time by turning it off when it is not necessary.

Select the **Enable Motion Blur** checkbox to turn on Motion Blur. Deselect this option to turn it off.

The **MB Shutter Angle** parameter refers to the workings of a conventional film camera. Normally the shutter is open to 180°, meaning that the shutter is open for half of each frame. Increasing the angle will keep the shutter open longer, creating a wider blur. Decreasing the MB Shutter Angle produces a narrower blur.

The **MB Smoothness menu** setting determines how many times the effect samples between the time the “shutter” opens and the time it closes. Increasing the samples creates a smoother blur but increases render and preview time proportionately. The choices are Low, Medium, High and Highest. **Low** uses the fewest samples, while **Highest** uses the most.
Working with the Title Crawl Filter

The Title Crawl filter enables you to easily animate a text page. The Title Crawl filter automatically keyframes the text page to roll or crawl across the screen. This filter automatically aligns and animates the text page so that you do not have to set keyframes in the timeline. You can also manually adjust the keyframes for precise control over the effect.

Creating a Title Animation

The basic steps for creating a title animation such as a credit roll are as follows:

1. Apply the Title Crawl filter. The Text window opens.
2. Create or import text in the Text window. You can type, import, and edit text, and control font, size, justification, color, opacity, spacing, shadows, and borders. The parameters in the Text window are applied on a character basis. For more information, see “Creating a Text Effect” on page 11.
3. Use the parameters in the Effect Controls window to apply an animation type to the text. See “Animating Text” on page 61 for more information.

Optimizing Workflow for Credit Rolls

When you work with large amounts of text, for example a long credit roll, you should consider the following workflow options.

- Create a text document in a word processor. This approach avoids tying up your system for long periods of time and reduces the risk of typographical errors. It is especially useful if the person responsible for the accuracy of the content is not the person who will create the roll. You can import a Simple Text or Rich Text document or you can simply cut and paste text. Then format the text in the Text window.
- Save the styles that you use for your credit roll in the Style Palette. Then you can quickly format long credit rolls.
Animating Text

The Effect Controls window contains parameters which control the movement of the text.

When the **Continuously Rasterize checkbox** is selected, the text is forced to recalculate based on Geometry parameter changes. While this is useful for specific types of effects, it is unnecessary for many effects and can slow performance - most noticeably when using sophisticated text styles. Select the Continuously Rasterize checkbox to improve image quality in the following situations.

- When the Scale parameters is set to scale the text much larger than 100% size.
- When using large negative Position Z values.
- When the Tumble or Spin parameters are set so that parts of the text appear very close to the viewer.
- When Rotating text with a bevel or emboss style and you want the highlight to recalculate accordingly.
When using the Continuously Rasterize option, set up the effect with the option disabled to improved preview performance. Then select the option as a final step to improve the render.

The 1:2:1 Deflicker parameter does not apply when Continuously Rasterize is enabled. If you select 1:2:1 Deflicker (see below) and then enable the Continuously Rasterize checkbox, 1:2:1 Deflicker is disabled.

When the Composite on Original checkbox is selected, the filter composites the text over the source image, which remains visible behind the text. When this checkbox is deselected, the text composites over an alpha channel.

The 1:2:1 Deflicker checkbox applies a vertical blur to the effect to help eliminate flickering and reduce jagged edges on moving graphics with hard edges. Select 1:2:1 Deflicker if Animation Style is set to Roll. Leave this option deselected if Animation Style is set to Crawl.

Opacity adjusts the opacity of the text. At a value of 0, text is completely transparent, and at a value of 100, text is completely opaque. Intermediate values produce varying degrees of transparency.

The Animation Style menu determines what type of animation is applied to the text. When Animation Style is set to None, the text is not animated. Each of remaining choices, Roll and Crawl, have their own controls which are described in detail in the following sections.

Roll moves the text up the screen. To create a roll, choose Roll from the Animation Style menu.
Crawl moves all the text horizontally across the screen. To create a crawl, choose Crawl from the Animation Style menu.

When you create a title crawl make sure that Text Wrap is set to No Wrap (in the Text window’s Page tab), and that no carriage returns were typed in the Text window. Otherwise, multiple lines will crawl across the screen.

Reverse Direction reverses the direction of the effect, moving the text from top to bottom instead of bottom to top if the Animation Style menu is set to Roll and from left to right instead of right to left if the Animation Style menu is set to Crawl.

Increase Speed (pix/sec) adjusts the speed at which the text rolls or crawls across the screen. Boris Title Toolkit automatically adjusts the Speed to fit the text to the duration of the effect. Select Maintain Speed to manually adjust the Speed. Speed has no affect if Maintain Speed is deselected.

Selecting the Use Percent Completion checkbox adjusts the timing of the effect. When Animation Style is set to Roll or Crawl, the speed is automatically adjusted to fit the text to the duration of the effect. Select Use Percent Completion checkbox to manually adjust the timing. Percent Completion has no affect if the Use Percent Completion checkbox is deselected. This is useful for pausing, but you have to manually keyframe the effect.

Mask Start and Mask End set the distance, in pixels, of masks at the top and bottom edges of the frame (if the Animation Style menu is set to Roll) which hide the text as it rolls. If the Animation Style menu is set to Crawl, this setting masks the left and right edges of the frame which hide the text as it crawls. For example, you may not want the text to be visible until it is inside the Title Safe area.
**Blend Start** and **Blend End** soften the edges of the mask, causing titles to “fade” into and out of the masked region. For example, you may want the text to fade in at the Title Safe area.

Page Header and Page Footer add space above and below the text if the Animation Style menu is set to Roll. If the Animation Style menu is set to Crawl, the space is added before and after the text. This value is expressed in pixels and is added to any Top and Bottom Margin settings created by the Page tab in the Text window.

The **Word Wrap menu** controls the position of the text when the text is wider than the screen.

- **No Override** uses the Text Wrap setting and Page Width that you set in the Text window. When you choose No Override, the Page Width and Justification menu settings in the Effect Controls window have no affect. For more information, see “Working with the Page Tab” on page 22.
- **Off** creates an unbroken line of text, allowing you to use the text as a continuous crawl. When you set the Word Wrap menu to Off, the Page Width that you set in the Text window is used. You can still use the **Justification menu** to override the Justification that you set in the Text window.
- **On** creates additional lines of text if the text exceeds the chosen Page Width value. As a word passes the limit of the Page Width, it moves to the next line. This option affects the **Justification menu** setting. For example, if you choose Left Justification with the Word Wrap menu set to On, the text is left justified within the specified Page Width. The Page Width and Justification menu settings override the settings set in the Text window. For more information on justification, see “Justifying Text” on page 18.

The **Enable Motion Blur checkbox** turns on Motion Blur. Deselect this option to turn it off.

The **MB Shutter Angle** parameter refers to the workings of a conventional film camera. Normally the shutter is open to 180°, meaning that the shutter is open for half of each frame. Increasing the angle will keep the shutter open longer, creating a wider blur. Decreasing the MB Shutter Angle produces a narrower blur.

The **MB Smoothness menu** determines how many times the effect samples between the time the “shutter” opens and closes in composing the render. Increasing the samples creates a smoother blur but increases render and preview times. The menu choices are Low, Medium, High and Highest. **Low** uses the fewest samples, while **Highest** uses the most.
Working with the Geometry Parameter Group

**Position X/Y** set the coordinates of the text’s center point. You can adjust or animate these values to offset the text as it moves in or out. When **Animation Style** is set to **Roll**, Title Toolkit automatically sets keyframes for Position Y in to move the text up the screen. Adjust Position X/Y to offset the rolled titles to the left or right. When **Animation Style** is set to **Crawl**, keyframes are automatically set for Position X to move the text across the screen. Adjust Position X/Y to offset the crawled titles upward or downward.

**Position Z** adjusts the apparent depth of the text. Decreasing negative values move the text closer to the viewer, while increasing positive values move the text farther away. Very low Position Z values move the text behind the viewer, making it invisible.

**Tumble**, **Spin**, and **Rotate** move the text around the X, Y, and Z axis respectively. Tumble, Spin, and Rotate can animate over values greater than 360° to make the image complete more than one full revolution.

When the **Lock Pivot to Position** checkbox is selected, the text tumbles, spins, and rotates around its own center. If this option is deselected, you can set an external pivot point around which to tumble, spin, or rotate. **Pivot X/Y** and **Pivot Z** set the X, Y, and Z coordinates of the pivot point. If the Lock Pivot checkbox is selected, moving the pivot point has no affect.
Working with the Vector Shape Filter

The Vector Shape filter allows you to quickly create color backdrops behind text. You can use one of the supplied shapes or create your own using the After Effects Pen tool. The backdrops can include texture maps, borders and shadows. The vector shapes include rectangle, wedge, oval, arrow, star, medallion, heart, grid, line and circle. You can add a border and set the fill of the backdrop using the Border and Fill parameter groups.

To create a backdrop behind text, you can apply the Vector Shape filter to a layer below the text layer in the timeline. Alternatively, you can apply the Vector Shape filter to the same layer as the text, making sure that the Vector Shape filter is above the text in the Effects Controls window. You also need to select the Composite on Original checkbox in the Vector Text filter.

When the Continuously Rasterize checkbox is selected, the vector form of the backdrop is forced to recalculate based on Transformations parameter changes. While this can be useful for specific types of effects, it is unnecessary for many effects and can slow performance - most noticeably when using sophisticated text styles.

Select the Continuously Rasterize checkbox to improve image quality in the following situations.

- When the Scale parameters are set to scale the backdrop much larger than 100% size.
- When using large negative Position Z values.
- When the Tumble or Spin parameters are set so that parts of the backdrop appear very close to the viewer.
- When Rotating backdrops with a bevel or emboss style and you want the highlight to recalculate accordingly.
When using the Continuously Rasterize option, set up the effect with the option disabled to improve preview performance. Then select the option as a final step to improve the quality of the render.

You do not need to select the Continuously Rasterize checkbox for any parameters other than Transformations. The Vector form of the backdrop is always recalculated for any scaling or rotating or repositioning in the Primitive Shape, Border 1, Border 2, Border 3, Shape Fill, Path Jitter, and Shadow parameter groups.

When the Composite on Original checkbox is selected, the filter composites the backdrop over the source image, which remains visible behind the backdrop. When this checkbox is deselected, the backdrop is composited over an alpha channel.

The AE Path Selector menu lets you use a path that you create in After Effects as a backdrop. Use the Pen tool to create the text backdrop. Then choose the appropriate mask from the AE Path Selector menu. When this menu is set to None, the chosen Shape Primitive menu setting is used instead.

If you delete an AE path while it is being used to define the backdrop, the Shape Primitive menu will become dimmed. To use the Shape Primitive menu, toggle the Continuously Rasterize checkbox at the top of the effect controls.

The Shape Primitive menu sets the shape of the backdrop. The choices are Rectangle, Wedge, Oval, Arrow, Star, Medallion, Heart, Grid, Line and Circle. Each shape has its own parameter controls which are described in the following sections.

**Working with the Primitive Shape Parameter Group**

The parameters in the Primitive Shape parameter group allow you to adjust the size and shape of the backdrop. Each shape offers its own controls.

**Working with the Rectangle**

When the Shape Primitive menu is set to Rectangle, Shape Left, Shape Top, Shape Right, and Shape Bottom control the positions of the corners of the rectangle. These values are scaled as percentages of the width and height of the Comp window.
Corner Size adjusts the size of the rectangle’s corners.

Corner Type menu sets the shape of the rectangle’s corners.

- Convex produces corners that curve inward.
- Concave produces corners that curve outward.
- Straight produces corners that are straight lines.
Working with the Wedge

When the Shape Primitive menu is set to Wedge, Wedge Start sets the location of the starting edge of the wedge. Increasing this value moves the starting edge around the Z axis.

![Wedge Start =0](image1) ![Wedge Start =90](image2) ![Wedge Start =180](image3)

Wedge Length specifies the distance between the starting and ending edges of the wedge, or the length of the arc which forms the outer edge of the wedge.

![Arc Angle=90](image4) ![Arc Angle=180](image5) ![Arc Angle=270](image6)
Working with the Oval

When the Shape Primitive menu is set to Oval, Shape Left, Shape Top, Shape Right, and Shape Bottom control the positions of the corners of a rectangle in which the oval is inscribed. These values are scaled as percentages of the width and height of the Comp window.

![Shapes](image1.png)

- Shape Top=0
- Shape Top=25
- Shape Top=63

Working with the Arrow

When the Shape Primitive menu is set to Arrow, the Arrow Type menu determines which way the arrow points. Choose Up, Down, Left, or Right.

![Arrows](image2.png)

- Arrow Type=Up
- Arrow Type=Down
- Arrow=Left
- Arrow Type=Right
Working with the Star

When the Shape Primitive menu is set to Star, **Number of Points** adjusts the number of points in the star. Higher values produce more points, while lower values produce fewer points.

![Number of Points=5](image1.png) ![Number of Points=10](image2.png) ![Number of Points=20](image3.png)

**Point Length** sets the length of each point in the star. Higher values produce longer points, while lower values produce shorter points.

![Point Length=25](image4.png) ![Point Length=50](image5.png) ![Point Length=75](image6.png)
Working with the Medallion

Medallion creates a medallion-shaped spline. The medallion shape is similar to a star, but with a greater number of shorter points. In addition, the medallion is stretched horizontally.

When the Shape Primitive menu is set to Medallion, **Number of Points** adjusts the number of points in the medallion. Higher values produce more points, while lower values produce fewer points.

![Examples of Medallion with different point counts](image)

**Number of Points=6**  **Number of Points=10**  **Number of Points=18**

**Point Length** sets the length of each point in the medallion. Higher values produce longer points, while lower values produce shorter points.

![Examples of Medallion with different point lengths](image)

**Point Length=25**  **Point Length=50**  **Point Length=75**

Working with the Heart

Heart produces a heart-shaped spline.

When the Shape Primitive menu is set to Heart, **Heart Roundness** adjusts the shape of the point at bottom of the heart. Lower values produce a more rounded point, while higher values produce a narrower point.

![Examples of Heart with different roundness levels](image)

**Heart Roundness=0**  **Heart Roundness=100**
Working with the Grid

Grid produces a grid–shaped spline.

**Grid Columns** and **Grid Rows** set the number of grid lines along the X and Y axes, respectively. By default the grid includes eight columns and six rows.

**Spacing X** and **Spacing Y** scale the distance between lines along the X and Y axes, respectively. These parameters are scaled as percentages of the grid's original width or height. To scale the size of entire grid, use the Scale parameter in the Transformations parameter group.

The **Hide Last Lines** menu lets you hide the corresponding extreme line. The choices are **None**, **All**, **Top and Bottom** and **Left and Right**.

**Grid Offset** allows you to set the starting position of the lines along the horizontal and vertical axes.

**Skew X** and **Skew Y** distort the lines along the horizontal and vertical axes, respectively.
Working with the Line

Line produces a line–shaped spline.

Point 1 and Point 2 allow you to set the starting and ending position of the line along the horizontal and vertical axes.

Working with the Circle

Point 1 and Point 2 allow you to set the center and radius of the circle along the horizontal and vertical axes. Point 1 sets the center point of the circular path. Point 2 sets the radius of the circle.

Working with the Border 1, Border 2 and Border 3 Parameter Groups

The Border 1, Border 2 and Border 3 parameter groups allows you to apply up to three different border styles to the backdrops. The parameters can be used to create beveled or glowing effects. By default, the Border 2 and Border 3 parameter groups are set to have no border.

Each parameter group offers the following controls.

The Edge Type menu controls the style of the border. The choices are None, Plain, Bevel and Radial. Each type has its own controls, which are described in the following sections.

When Edge Type is set to Plain, Edge Position sets the location of the border.

- **Inside** positions the border on the inside of the edges.
- **Outside** positions the border on the outside of the edges.
- **Center** centers the border over the edges of the selected character(s), so half of the border is on the inside of the edges, and half on the outside.
Working with the Plain Edge Type

Plain applies a flat border to the backdrop.

**Edge Color** sets the color of the border. Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen.

**Edge Width** sets the width, in pixels, of the border.

**Edge Opacity** adjusts the opacity of the border. A setting of 100 makes the border completely opaque, while a setting of 0 makes the border completely transparent.

**Border Begin** and **Border End** adjust the percentage of the border that is visible at each frame in the timeline, allowing you to create animated border effects. These values are measured as a percentage of the complete border. For example, if Border Start is set to 0 and Border End is set to 50, the first half of the border is visible. If Border Start is set to 50 and Border End to 100, the second half of the border is visible.

![Effect with Border End animated from 0 to 100.](image)

When Plain is selected, **Edge Softness** softens the edge of the border. A value of 0 creates a border with a hard edge, and raising this value increasingly softens the border.

When Edge Style is set to Plain, the **Cap menu** controls the shape of the ends of the border.

- **Flat** creates flat ends.
- **Round** adds a circular cap to the end of the border, which slightly lengthens the border and creates a rounded end.
- **Square** adds a square cap to the end of the border, which slightly lengthens the border and creates a flat end with square corners.
The **Join menu** determines the shape of the corners of the border. Choose **Round** to create rounded corners, **Miter** to create corners with sharp points, or **Bevel** to create clipped corners.

![Join menu examples](image)

**Working with the Bevel Edge Type**

Bevel creates a beveled border effect.

When Bevel is selected, **Highlight Color** sets the color of the lightest parts of the bevel.

**Shade Color** sets the color of the darkest parts of the bevel.

**Highlight Angle** sets the angle between the highlights and the horizontal axis.

![Bevel examples](image)
**Working with the Radial Edge Type**

Radial creates a soft glowing border effect.

When Radial is selected, **Outside Color** sets the color of the soft edges of the border.

**Radial Fade** controls the opacity of the outer edge of the border. When Radial Fade is 0, the outer edge is opaque. Higher Radial Fade values increase the transparency of the edge, and at a value of 100, the outer edge is transparent.

![Examples of Radial Fade](image)

**Edge Softness** softens the edges of the border. A value of 0 creates a border with a hard edge, and raising this value increasingly softens the border.

**Working with the Shape Fill Parameter Group**

The Shape Fill parameters set the fill of the backdrop.

Select the **Fill On** checkbox to turn on the fill. Deselect this option to leave the backdrop unfilled.

**Fill Opacity** determines the opacity of the fill.

**Fill Color** sets the color of the fill. Click the color chip to access the system color picker or use the eyedropper to choose a color from the screen.

The **Texture Map Layer menu** allows you to map media onto the backdrop. Choose the appropriate layer from the Texture Map Layer menu. When the Texture Map Layer menu is set to None, the chosen Fill Color is used.

The **Map Method menu** controls how the media is mapped onto the backdrop. The following example shows a still image of a flower as a texture.

![Examples of Map Methods](image)
• Choosing **Tile** repeats the texture image on the face of the backdrop. When you choose Tile, decrease the **Tile Size X** and **Tile Size Y** parameters to better see the tiled image within the backdrop.

• Choosing **Stretch** sizes the texture image to fit the backdrop. Stretch can distort the image, depending on its aspect ratio.

• Choosing **Clip** allows you to independently size and position the texture image on the backdrop. When you choose Clip, **Scale X** and **Scale Y** resize the texture image along the X and Y axis respectively.

**Offset X** and **Offset Y** move the center of the Texture image along the X and Y axis respectively. This repositions the texture within the text. These parameters have no affect when you choose Stretch as the Map Method.

### Working with the Path Jitter Parameter Group

The Path Jitter parameter group allows you to randomize the backdrop’s Position. These parameters only apply to a path created as a mask in After Effects and chosen in the AE Path Selector menu. They do not apply to Shape Primitive backdrops. The Path Jitter parameters are expressed as a percentage. All parameters have a range of 0 to 100, except for Scale which has a range of 0 to 600.

**Jitter X** and **Jitter Y** randomize the backdrop on the X and Y axis respectively.

**Jitter Velocity** varies the speed of the Jitter.

**Jitter Seed** varies the amount of Jitter from frame to frame.

### Working with the Transformations Parameter Group

**Opacity** adjusts the opacity of the text. A setting of 100 makes the text completely opaque, while a setting of 0 makes the text completely transparent.

**Position X / Y** set the coordinates of the text’s center point. You can adjust or animate these values to offset the text as it moves in or out

**Position Z** adjusts the apparent depth of the text. Decreasing negative values move the text closer to the viewer, while increasing positive values move the text farther away. Very low Position Z values move the text behind the viewer, making it invisible.

**Master Scale** lets you adjust Scale parameters globally. Parameters can still be changed independent of one another by using the individual Scale parameters. For example, you set Scale X to 100 and Scale Y to 200 to create a backdrop that is stretched vertically. If you then set Master Scale to 200, the resulting backdrop is twice as wide and four times as tall as the original.

**Scale X** and **Scale Y** change the size of the backdrop along the X and Y axes, respectively. These parameters are scaled as percentages of the object’s original width or height. Thus, a Scale X setting of 200 produces a backdrop twice as wide as the original.
**Tumble, Spin, and Rotate** move the backdrop around the X, Y, and Z axis respectively. Tumble, Spin, and Rotate can animate over values greater than 360° to make the image complete more than one full revolution.

![Tumble = -65 Degrees](image1)

![Spin = 65 Degrees](image2)

![Rotate = 65 Degrees](image3)

When the **Lock Pivot to Position** checkbox is selected, the text tumbles, spins, and rotates around its own center. If this option is deselected, you can set an external pivot point around which to tumble, spin, or rotate. **Pivot X/Y** and **Pivot Z** set the X, Y, and Z coordinates of the pivot point. If the Lock Pivot checkbox is selected, moving the pivot point has no affect.
Working with the Shadows Parameter Group

The Shadows parameter group applies one of three types of animatable shadows to the backdrop.

The **Shadow Type menu** determines what type of shadows are created.

- **None** does not apply a shadow.
- **Drop shadows** fall a specified distance from the object.
- **Cast shadows** appear to fall on another object; therefore the appearance and shape of this type of shadow depends on the distance between the two objects, and the shape of the object on which the shadow falls.
- **Solid shadows** simulate the appearance of a 3D object by applying a gradient to a shadow. Solid shadows are useful if you want to create text with a three dimensional appearance but do not need to apply transformations that would reveal that the text is actually 2D.

**Shadow Color** sets the color of the shadow. Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen. You can also apply colors from the Style Palette. For more information, see “Working with the Style Palette” on page 36.

**Shadow Distance** sets the distance between the shadow and the text. Use a small value to offset the text slightly; use a larger value to create distinct shadows that appear to fall on another surface.

**Shadow Opacity** sets the degree of opacity. A value of 100 makes the shadow completely opaque. Lowering this value makes the shadow increasingly transparent. A value of 0 creates a completely transparent shadow.

**Shadow Softness** softens the edges of the shadows, emulating the appearance of shadows cast by a diffuse light source. A value of 0 creates shadows with hard edges. Increasing this value softens the shadow edges.

**Shadow Angle** sets the angle between the shadow and the horizontal axis of the text.

When the **Shadow Type menu** is set to **Solid Shadow**, **Highlight Color** sets the color of the highlighted areas of the shadow, and **Shade Color** sets the color of the shaded areas. Click the color chip to access the system color picker, or use the eyedropper to choose a color from the screen. These parameters have no affect with any other shadow type.
Working with the Text Scrambler

The Text Scrambler generates random text or numbers. You can lock each letter or number in position regardless of changes made to neighboring characters. A typical example would be a timecode or numerical countdown or an effect that reveals text.

Many of the Text Scrambler parameters are similar to the Vector Text parameters. For instance, you could use either filter to create a text on a path or type on effect. However, the Text Scrambler also allows you to randomize text. Conversely, the Vector Text filter allows you to create animatable shadows and borders. The Text Scrambler does not include a Border and Shadows parameter group.

When the Continuously Rasterize checkbox is selected, the Vector form of the text is forced to recalculate based on Page Transformations parameter changes. While this can be useful for specific types of effects, it is unnecessary for many effects and can slow performance - most noticeably when using sophisticated text styles.

Select the Continuously Rasterize checkbox to improve image quality in the following situations.

- When the Scale parameters are set to scale the text much larger than 100% size.
- When using large negative Position Z values.
- When the Tumble or Spin parameters are set so that parts of the text appear very close to the viewer.
- When Rotating text with a bevel or emboss style and you want the highlight to recalculate accordingly.
When using the Continuously Rasterize option, set up the effect with the option disabled to improve preview performance. Then select the option as a final step to improve the quality of the render.

You do not need to select the Continuously Rasterize checkbox for any Transformations other than Page Transformations. The Vector form of the text is always recalculated for any scaling or rotating or repositioning of text characters in the Variations, Letter Transformations, Path, Type On, Jitter, and Texture Map parameter groups.

When the Composite on Original checkbox is selected, the filter composites the text over the source image, which remains visible behind the text. When this checkbox is deselected, the text is composited over an alpha channel.

**Working with the Variations Parameter Group**

The Variations parameter group provides a way to generate random text or numbers. You can lock each letter or number in position regardless of changes made to neighboring characters. A typical example would be a timecode or numerical countdown.

The Generator Type menu determines the type of text that is generated. The choices are *User Text*, *Random Text*, *Random Numbers* and *Numbers*. Each choice has its own parameters which are described in detail in the following sections.

**User Text Generator Type**

When you set the Generator Type menu to User Text, the following parameters apply.

When Generator Type is set to User Text, the text created or imported in the Text window is used. The following examples were all created with the example at right.

When you adjust User Text Variation, each ASCII character value offsets by a certain amount. Notice that this does include spaces between words. This parameter is expressed as an offset with a range of 0 to 100. When Letter Variation is 0, no variation occurs. In the example at right, Letter Variation is 6. You can use the Scramble Characters parameter to randomize the offset.
The Variation Mode menu allows you to vary the characters included in the effect.

When you experiment with the choices in the Variation Mode menu, it is helpful to scrub User Text Variation to see how the animated text will vary.

The Variation Mode menu examples use the text and styles in the following illustration. The examples show one frame in an animation where the text is constantly changing.

Text entered into Text window

- **Alphabetical Text** uses only alphabetical characters, offset by the Letter Variation amount. For example, all the “l” characters from the original “Grilled” word are now “w.”

- **Random Text** uses only alphabetical characters, but the characters are randomized. So the “l” characters from the original “Grilled” word would not necessarily be the same.

- **Random User Text** uses only the alphabetical characters that are included in the original user text. In this example, only the characters a, b, c, d, e, g, h, i, l, n, p, r, s, and t would be used.
• **Style Shift** uses the original user text but randomizes the styles that are applied to each character from left to right. The text must use multiple styles or this choice has no affect.

• **Random Style** is similar to Style Shift except that it randomizes the styles instead of moving from left to right. The text must use multiple styles or this choice has no affect.

• **Style Shuffle** randomly shuffles the styles assigned to each character to that of another style used in the Text window. The text must use multiple styles or this choice has no affect.

• **Style by Word** looks at the style of the first letter of each word and assigns that style to entire words at random.

• **Style by Line** looks at the style of the first letter of each line and assigns that style to entire lines at random.

• **Style Shuffle by Word** looks at the style of the first letter of each word and shuffles that style with other words.
• **Style Shuffle by Line** looks at the style of the first letter of each line and shuffles that style with other lines.

The **Progress** parameter allows you to control which characters change. The amount is animatable so that you can achieve the popular effect of letters flipping until your word forms. In the example at right, only the first two letters animate. If Letter Variation is 0, Progress has no affect. Progress is expressed as a percentage.

The **Progress Order menu** sets the direction of the progress. The choices are **Left to Right**, **Right to Left** and **Random**.

**Scramble Characters** allows you to vary the characters from frame to frame. When you use Letter Variation parameter to adjust the characters, the characters are offset by the same amount. For example, all the “e” characters from the original “Generator” text are now “x.” You can randomize this, using the Scramble Characters parameter.

The **Repeat** parameter allows you to create longer bodies of text. The range is from 1 to 1000. At a value of 1, the text appears once. Do not forget line feeds to avoid hitting the horizontal text size limit. This parameter is also animatable. In the example at right, Repeat is 13.

The **Loop** parameter cycles through the characters, determining which character starts the line. You can animate this parameter to make the characters appear to crawl in place. Whole numbers have no affect; decimal numbers move the characters to the left or right. In the example at right, Loop is 0.12.
Generated Text Generator Type

When you set the Generator Type menu to Generated Text, the following parameters apply.

When the Generator Type menu is set to Generated Text, user input is ignored except for style properties. The idea is to mimic large bodies of text (sometimes called Greek text in page layout programs) or to create design elements and background with text shapes.

Scramble Characters allows you to vary the characters from frame to frame. When you use Letter Variation parameter to adjust the characters, the characters are offset by the same amount. For example, all the “e” characters from the original “Generator” text are now “x.” You can randomize this, using the Scramble Characters parameter.

Animate Random Seed to randomize the change of the text characters from frame to frame.

Line Length sets the character count in each line.

Line Count sets the number of lines. In the example at right, Line Count is 1.
Use **Word Break** to generate word breaks or spaces. At a value of 10, no breaks are generated. At lower values, breaks appear at random. The lower the value the more frequent the breaks (or the smaller the average word size becomes).

The **Character Type menu** sets the type of characters that make up the random text:

- **Upper Case** displays all upper case letters.
- **Lower Case** displays all lower case letters.
- **Mixed Case** displays a random mix of upper and lower case letters.
- **Capital Words** displays words with the initial letter capitalized.
- **Numbers** randomly displays numbers.
- **Non Alpha** randomly displays only non-alpha-numeric characters such as punctuation marks and symbols.
- **All Printable** randomly displays all the characters on the keyboard, with randomly mixed cases.
- **User Text Characters** randomly displays only the characters that appeared in the Text window. For example, if the original text was “Coming Soon,” only the characters c, o, m, i, n, g, and s would appear in the generated text.
Random Numbers Generator Type

The Random Numbers Generator Type is similar to Random Text, except it only generates numbers. When Generator Type is set to Random Numbers, random numbers are generated on the screen. User input is ignored except for style properties. When you set the Generator Type menu to Random Numbers, the following parameters apply.

Scramble Characters allows you to randomly vary the numbers from frame to frame.

Animate Random Seed to randomly vary the numbers from frame to frame.

Adjust Precision to set the number of digits after decimal point. Set Precision to 0 to generate whole numbers.

If you are using a Numbers Generator and animating the Numeric value over a period of time, Precision can only offer a running count that is truly more precise if the range of Numeric values being animated between allows for the number to update frequently enough.

In other words, if you are using a Precision of 2 (showing 2 decimal places) but your animation is set up to require the whole number value to change every frame, the numbers after the decimal place will not look correct.

Field size determines the minimal total number of positions. This includes all symbols such as a plus or minus sign. Spaces are used in the left of the number if not all positions are used.
The **Show Plus** checkbox allows you to display a plus sign before the number. This option is selected in the example at right.

Select the **Leading Zeros** checkbox to display zero’s before the number. This option is selected in the example at right.

Select the **Allow Negative** checkbox to allow negative numbers.

**Numbers Generator Type**

The Numbers Generator Type is similar to Random Numbers, except that Random Seed is replaced by **Numerical Value** so that the numbers can be animated sequentially. The Negative checkbox is not included because the Numeric Value parameter has a negative range as well as positive. The range of this parameter is -64,000 to 64,000. When you set the Generator Type menu to Numbers Generator, the following parameters apply.

**Scramble Characters** allows you to randomly vary the characters from frame to frame.

Adjust **Numeric Value** to display a specific number.

The rest of the parameters in the Numbers Generator Type are the same as Random Numbers. See the previous section for a description of how these parameters work.

**Working with the Page Transformations Parameter Group**

The Page Transformations parameter group allows you to add basic DVE moves to your text. For example, generate random text and then use these parameters to spin the text.

**Opacity** adjusts the opacity of the text. A setting of 100 makes the text completely opaque, while a setting of 0 makes the text completely transparent.

**Position X** / **Y** set the coordinates of the text’s center point. You can adjust or animate these values to offset the text as it moves in or out.

**Position Z** adjusts the apparent depth of the text. Decreasing negative values move the text closer to the viewer, while increasing positive values move the text farther away. Very low Position Z values move the text behind the viewer, making it invisible.

**Master Scale** lets you adjust Scale parameters globally. Parameters can still be changed independent of one another by using the individual Scale parameters. For example, you set Scale X to 100 and Scale Y to 200 to create text that is stretched vertically. If you then set Master Scale to 200, the resulting text is twice as wide and four times as tall as the original.

**Scale X** and **Scale Y** change the size of the object along the X and Y axes, respectively. These parameters are scaled as percentages of the object’s original width or height. Thus, a Scale X setting of 200 produces text twice as wide as the original text.
**Tumble, Spin, and Rotate** move the text around the X, Y, and Z axis respectively. Tumble, Spin, and Rotate can animate over values greater than 360° to make the image complete more than one full revolution.

![Tumble = -65 Degrees](image1)
![Spin = 65 Degrees](image2)
![Rotate = 65 Degrees](image3)

When the **Lock Pivot to Position** checkbox is selected, the text tumbles, spins, and rotates around its own center. If this option is deselected, you can set an external pivot point around which to tumble, spin, or rotate. **Pivot X/Y** and **Pivot Z** set the X, Y, and Z coordinates of the pivot point. If the Lock Pivot checkbox is selected, moving the pivot point has no affect.
Working with the Letter Transformations Parameter Group

**Tracking** controls the global horizontal spacing of the characters in the effect. Unlike the Tracking parameter in the Text window, you can animate this tracking parameter.

![Tracking Examples](image)

Letter Skew X and Letter Skew Y distort text along the horizontal and vertical axis.

![Letter Skew Examples](image)

**Master Letter Scale** lets you adjust Letter Scale parameters globally. Parameters can still be changed independent of one another by using the individual Letter Scale parameters. For example, you set Letter Scale X to 100 and Letter Scale Y to 200 to create text that is stretched vertically. If you then set Master Letter Scale to 200, the resulting text is twice as wide and four times as tall as the original.

**Letter Scale X** and **Letter Scale Y** set the scale of the text along the horizontal and vertical axis. These parameters differ from the Page Transformations parameter group’s Scale X and Scale Y parameters, which scale the entire text layer. For example, if you set Scale X to 200, the resulting text is stretched twice as wide as the original. If you set Letter Scale X to 200, the resulting text is stretched twice as wide as the original but the characters would overlap since Letter Scale affects each letter. This is useful for creating animating tracking or type on effects.
Letter Tumble, Letter Spin, and Letter Rotate rotate the text characters around their baseline’s X, Y, and Z axis, respectively. Compare how this appears with the Page Transformations parameter group’s Tumble, Spin and Rotate parameters which move the entire text layer around the axis.

Working with the Path Parameter Group

The Path parameters allows you to create text on a path—that is, text which wraps around a spline.

The Path Type menu lets you choose the type of path.

- **AE Path** allows you to use a path that you create in After Effects by creating a new mask with the Pen tool. Once you create the path, choose it from the Text Path menu.
- **Circle** allows you to create a circular path by setting the Point 1 and Point 2 parameters. Point 1 sets the center point of the circular path. Point 2 sets the radius of the circle.
- **Line** allows you to create a linear path by setting the Point 1 and Point 2 parameters.

The On Path Motion dial adjusts the position of the text on the path. You can animate over values greater than 360° to make the text finish more than one full revolution on the path.

Angle to Path allows you to control how text is positioned on the path. When Angle to Path is at the default value of 100, the Text position follows the curve of the path. As Angle to Path values approach 0, the text becomes more vertical on the path, regardless of the path’s curve.
The Alignment menu allows you to set the justification of text on path. This creates a much wider range of design possibilities. Adjusting justification, rather than only the position of text on a path, also means that you can create settings with centered text that won’t require adjustment if the length of the text changes. The Alignment menu includes the following choices.

- **Left** aligns the text so that each line starts at the beginning of the path. This is the default.
- **Center** centers the text on the length of the path.
- **Right** aligns the text so the end of the line matches the end of the path.
- **Distribute** justifies the text along the length of the path.

The Alignment control is also useful if you want to preview how your text will appear along the path while you are creating your effect. Set the Alignment menu to Distribute to determine how the effect will appear as it travels the path. Then choose the appropriate alignment when you finish.

Select the Reverse Path checkbox to map the text to the underside or inside of the path.

**Path Jitter X** and **Path Jitter Y** vary the position of the text on the path along the X and Y axis, respectively. Higher values produce more jitter, and increase the amount that the position varies from frame to frame.

**Path Jitter Velocity** allows you to control the speed of the Path Jitter X and Path Jitter Y parameters.

**Path Jitter Seed** varies the amount of Jitter from frame to frame.
Working with the Type On Parameter Group

The Type On parameter group offers several options for creating animated writing or “type-on” effects.

**Text Type On** adjusts the percentage of the text that is visible in each frame, allowing you to create animated typing effects. This value is measured as a percentage of the complete text. For example, if Text Type On is set to 50, the first half of the text is visible. If Text Type On is set to 100, all the text is visible.

The **Type On Order menu** allows you to control the order in which the text types on. The **Type On Order menu** includes the following options:

- **Forward** types on the text from left to right.
- **Reverse** allows you to reverse the effect so that the text types on starting from the left.
- **Random** types the text type on randomly.
Press the **Apply To** menu and choose the appropriate option.

- **Letter** applies the effect to individual letters and characters.
- **Word** applies the effect to individual words. Words are defined as characters that are separated by a space in the Text window.
- **Line** applies the effect to individual lines. Lines are defined as characters that are separated by a carriage return in the Text window.

Click the **Always Visible** checkbox to force all text characters to remain visible. The Type On feature applies transformations progressively to text characters. When this checkbox is deselected, characters progressively appear or disappear from the frame. Selecting the Always Visible checkbox forces characters to remain visible while the transformations are progressively applied. One way to think of this effect is like “the wave” that crowds perform at football stadiums. The transformation appear to pass through the text. The animatable Type On parameter behaves as the center of the wave when this checkbox is enabled.

**Animated Text Scrambler effect with “Always Visible” enabled.**

**Reveal Time** controls how long each character animates during the effect. This parameter only affects animations created with the Fade, Shift, Skew, Tumble, Spin, and/or Rotate parameters (described below). For example, you create a four second type-on effect with the word “Text.” If Text Type On is animated from 0 to 100, each letter in the word Text animates onscreen for one second. Reveal Time specifies the percentage of that one second that the
Fade, Shift, Skew, Tumble, Spin, and/or Rotate lasts. Thus if Reveal Time is 50, each character Fades, Shifts, Skews, Tumbles, Spins, and/or Rotates for 0.5 seconds (50% of 1), and subsequently remains stationary for the rest of the effect. In this case, the next letter does not appear for another 0.5 seconds after the previous letter stops animating.

**Acceleration** allows you to gradually accelerate the effect.

**Overshoot** allows you to create bouncing text effects, when combined with any parameters except Fade. Each character moves past its destination position or scale by the value specified in Overshoot before returning to its destination position or scale. This parameter only affects animations created with the Shift, Scale, Skew, Tumble, Spin, and/or Rotate parameters. If all of these parameters are set to the default, Overshoot has no affect.

**Decay** works in conjunction with the Overshoot parameter. Decay is expressed as a percentage that allows you to exponentially decrease the Overshoot. For example, you set the Shift Y so that the characters move in from the top of the frame with an Overshoot of 300. Setting Decay to 50 means that each of the three bounces will decay by half.

**Fade** allows you to gradually fade in successive characters. When Fade is set to 100, each character appears suddenly and is fully opaque. Decreasing this value creates a more gradual effect, in which each character fades on as its opacity increases.

**Shift X** and **Shift Y** adjust the starting position of the characters in relation to their destinations on the screen. For example, if the text is placed in the center of the screen and Shift X is set to 320, when Text Type On is animated, each character first appears on the right side of the screen, then moves toward the center.

Type-on effect with Shift X set to 320.

`T` `E` `X`  
Time 00:00:01:11  Time 00:00:01:18  Time 00:00:01:24

**Scale X** and **Scale Y** adjust the starting size of the characters. The default value is 100, in which the text types on the screen full size. If you decrease the value, the text appears to grow on the screen as it types.

`T` `E` `X`  
Scale Y = 200  Scale X = 200  Scale Y/Scale X= 200
**Skew X** and **Skew Y** set the starting Skew values for the characters in relation to their final skew values (controlled by the Skew X and Skew Y values set in the Text window and in the Page Transformations parameter group). Each character animates from its starting Skew values to its ending Skew values as it appears on screen.

Type-on effect with Skew X set to 180.

![Type-on effect with Skew X set to 180.](image)

**Tumble, Spin, and Rotate** set the starting Tumble, Spin, and Rotate values for the characters in relation to their final Tumble, Spin, and Rotate values (controlled by the Letter Tumble, Letter Spin, and Letter Rotate values set in the Letter Transformations parameter group and by the Tumble, Spin, and Rotate controls in the Page Transformations parameter group). Each character animates from its starting Tumble, Spin, and Rotate values to its ending values as it appears on screen.

Type-on effect with Rotate set to 180.

![Type-on effect with Rotate set to 180.](image)

**Jitter Position** randomizes the position of the individual text characters on the X and Y axis.

**Jitter Angle** randomizes the angle of the individual text characters. Angle distorts text on the X and Y axes, respectively.

**Jitter Scale** randomizes the scale of the individual text characters.
Working with the Jitter Parameter Group

The Jitter parameter group allows you to randomize text parameters including Position, Angle, Scale, Hue and Opacity. The Jitter parameters are expressed as a percentage and are applied to individual text characters. All parameters have a range of 0 to 100, except for Scale which has a range of 0 to 600.

The Jitter parameters are similar to the Jitter parameters in the Type On parameter group. When you apply Jitter parameters in the Type On parameter group, they are applied progressively to each character as it types on. When you apply these parameters in the Jitter parameter group, they apply to all characters. When you set values for these parameters in both the Type On and Jitter parameter groups, the parameters in the Type On parameter group are applied to individual characters until the character is typed on; the parameters in the Jitter tab are applied after each character is typed on.

Jitter Seed varies the amount of Jitter from frame to frame.

Jitter Speed varies the speed of the Jitter.

Jitter Position X and Jitter Position Y randomize the position of individual text characters on the X and Y axis respectively.

Jitter Angle randomizes the angle of the individual text characters. Angle distorts text on the X and Y axis.

Jitter Scale X and Jitter Scale Y randomize the scale of the individual text characters on the X and Y axis respectively.

Jitter Hue randomizes the color of the individual text characters. Hue sets the color fill of the text.

Jitter Opacity randomizes the transparency of the individual text characters.

The Restrictions menu lets you restrict the Jitter parameters. For example, you can restrict the Jitter Scale X and Y parameters so that they only scale larger than the original text.

- None does not restrict the parameters.
- Positive Only restricts the parameters so that the values can only be higher than the original parameter.
- Negative Only restricts the parameters so that the values can only be lower than the original parameter.
Polarize lets you alternate the Jitter parameters for characters. At more extreme values, every other character will alternate.

Master Jitter Amount scales the Jitter parameters globally. Parameters can still be changed independent of one another by using the individual parameters. For example, you set Jitter Position X to 100 and Jitter Position Y to 200 to create text that is jitters vertically. If you then set Master Jitter Amount to 200, the resulting text jitter twice as much as the original.

Working with the Texture Map Parameter Group

The Texture Map parameter group allows you to map media onto Text. You can map media to the face or faces of text or to the text backdrop.

Choose the appropriate layer from the Texture Map Layer menu.

The Map Method menu controls how the media maps onto the text. The following example shows a still image of a flower as a texture.

Flower as Texture Map
Tile Map Method
• Choosing **Tile** repeats the texture image on the face of the text. When you choose Tile, decrease the **Tile Size X** and **Tile Size Y** parameters to better see the tiled image within the text.

• Choosing **Stretch** sizes the texture image to fit the text. Stretch can distort the image, depending on its aspect ratio.

• Choosing **Clip** allows you to independently size and position the texture image on the text. When you choose Clip, **Scale X** and **Scale Y** change the size of the texture image along the X and Y axis respectively.

**Offset X** and **Offset Y** move the center of the Texture image along the X and Y axis respectively. This repositions the texture within the text. These parameters have no affect when you choose Stretch as the Map Method.

**Working with the Motion Blur Parameter Group**

Select the **Enable Motion Blur** checkbox to turn Motion Blur on. Deselect this option to turn it off.

Enabling or disabling Motion Blur is not global to the effect. Motion Blur can be keyframed and enabled for only portions of the effect. This allows you to save processor time by turning it off when it is not necessary.

The **MB Shutter Angle** parameter refers to the workings of a conventional film camera. Normally the shutter is open to 180°, meaning that the shutter is open for half of each frame. Increasing the angle will keep the shutter open longer, creating a wider blur. Decreasing the MB Shutter Angle produces a narrower blur.

The **MB Smoothness menu** setting determines how many times the effect samples between the time the “shutter” opens and the time it closes in composing the render. Increasing the number of samples creates a smoother blur but increases render and preview time proportionately. The menu choices are **Low, Medium, High and Highest. Low** uses the fewest samples, while **Highest** uses the most.
About the Tutorial Exercises

The following tutorial exercises provide step-by-step instructions for creating various kinds of text effects. These tutorials do not require any specific media files, although the first exercise uses an imported text file. If you do not have the text file, you can complete the exercise by typing or importing text. Some of the exercises use fonts that you may not have on your system. You can replace them with any fonts that you like.

Exercise 1: Creating a Rolling Title Effect

Title Crawl allows you to easily create title rolls and crawls. The text is automatically aligned and animated so that you do not have to set keyframes in the timeline.

You can create a title page in the Text window where you can type, edit or import text and set the font, size, justification, color, opacity, spacing, shadows, and borders. The parameters in the Text window are applied on a character basis, meaning that you can apply separate styles to different characters.

The Style Palette allows you to save favorite styles and apply them to other text effects. These styles can be copied and shared with other users or used on other computers. In this exercise you will create a title roll then save and apply the styles.

Creating a Title Page

1. Create a new composition and add the media that you want to use as the background to the timeline. These exercises use a solid color, but you can use whatever you like.
2. Set the duration of the composition to ten seconds.
3. Select the background layer in the timeline.
4. Choose Effects > Boris > Title Crawl.
   The Text window opens.
5. Click the Import File button at the bottom of the Text window. In the dialog box that opens, navigate to the “Credits.txt” file and click OK.

If you have not downloaded this file, simply click in the top of the Text window and type several lines of alternating text. The examples in this exercise show a credit roll, but you can use whatever sort of text you like.

6. Press Command-A (Macintosh) or Control-A (Windows) to select all the text.
7. In the Style tab in the Text window, use the menus to set the font and size of the text and center justify the text. You may want to increase the size of the text to a point size over 40 depending on which font you choose.
8. In the Text window, select only the first line of text. (The words “Senior Producer” if you are using the imported file.)

9. Click the Color Fill tab to open the color fill controls. Use Style Color to choose a color for the text.

10. Select the “Boris Yamnitsky” text and assign this text a different color.

11. Click Apply to display the changes you made in the Comp window. The Text window will automatically close.

Saving and Applying Styles
You can use the Style Palette to save, name, and apply styles for future use.

1. Click the Title Crawl filter’s banner in the Effect Controls window to reopen the Text window.

2. Click the Style Palette button in the bottom of the Text window.
3. To create a category for your styles, click the **Add Category** icon. Type the name “Credit Roll Styles” in the dialog box and click **OK**.

4. To add the current style to the selected category, select the “Boris Yamnitsky” text in the Text window and click the **Add Style** icon.

5. Click the thumbnail for the new style, click the **Rename Style** icon, type “Name Style” in the dialog box and click **OK**. The thumbnail and name of the style appear in the right column.

6. In the Text window, select the “Senior Producer” text and click the **Add Style** icon. Enter the name “Title Style” in the dialog box and click **OK**. The thumbnail and name of the style appear in the right column.

7. Now you will apply the saved styles to the remaining text. Press Command-A (Macintosh) or Control-A (Windows) to select all the text. Double-click the “Title Style” thumbnail in the Style Palette to apply that style to all the text in the Text window.

8. Select the “Boris Yamnitsky” text and double-click the Name Style thumbnail in the Style Palette to apply that style. Repeat this step for each remaining line that contains a name.

9. Close the Style Palette.

10. Click **Apply** to close the Text window.

**Rolling the Text Page**

In this section you will roll the text page you created.

1. In the Effect Controls window, select the 1:2:1 **Deflicker** checkbox to apply a vertical blur to help eliminate flickering and reduce jagged edges.

2. Make sure that the **Composite on Original** checkbox is selected. When this is selected, the filter composites the text over the source layer. When this checkbox is deselected, the text is composited over an alpha channel. Layers in the timeline that are below the filtered layer are visible.

3. Set the **Animation Style** menu to **Roll**.
4. Preview the composition. The title page is automatically positioned and animated to roll up the screen in order.

Masking the Edges of the Text Frame
Now you will mask the edges of the text frame so that the credit roll appears to fade in and out at the Title Safe Area.

1. In the Effect Controls window, adjust **Mask Start** and **Mask End** to mask the text at the edges at the top and bottom edges of the frame.
2. In the Effect Controls window, adjust **Blend Start** and **Blend End** to soften the edges of the mask.
3. Preview the composition. The title page is automatically positioned and animated to roll up the screen in order.

Exercise 2: Creating an Animated Type On Effect
Vector Text allows you to easily create animated text effects. The Type On parameter group allows you to create animated type on effects.

1. Create a new composition and add the media that you want to use as the background to the timeline. These exercises use a solid color, but you can use whatever you like.
2. Set the duration of the composition to ten seconds.
3. Select the background layer in the timeline.
4. Choose Effect > Boris > Vector Text.
5. The Text window appears. Click in the window and type “extreme” then press Return and type “OVERSHOOT.”
6. Double-click to select the word “extreme” and make any adjustments to the font, text color, shadow and fill properties.
   The illustrations in this exercise use Arial Black font at 72 points, but you can use whatever type of text you like.
7. In the Text window, double-click to select the word “OVERSHOOT” and make any adjustments to the font, text color, shadow and fill properties.
   The illustrations in this exercise use Eddie Fisher font at 132 points, but you can use whatever type of text you like.
8. Click the Force Center Justification button.
9. When the text appears the way that you want, click Apply then close the Text window.
   Make sure that Text Wrap is set to No Wrap. This parameter is found in the Page tab in the Text window. By default it is set to No Wrap.
10. In the Effect Controls window, select the Composite on Original checkbox.
11. Click the disclosure triangle to expand the Type On parameter group.
12. Click the Stopwatch to create a keyframe for Text Type On at the first frame of the layer. Set Text Type On to 0.
13. Set Reveal Time to 1200 and Fade to 0.
14. Move the current-time marker to time 00:00:03:15 in the layer. Set Text Type On to 100.
15. Preview the animation. Several characters fade on at a time.

Changing the parameters under the Type On tab affects each character as it “types” onscreen. You will try adjusting some of the other parameters to experiment with other animation effects.
16. Select the first keyframe in the layer. In the Type On parameter group, set Shift Y to \(-480\). Set Scale Y to 3000.

17. Preview the animation. The text now scales and shifts as it types on screen.

18. Select the first keyframe in the Text track. In the Type On parameter group, set Overshoot to \(-100\).

19. Preview the animation. The text now appears to bounce as it scales and shifts.

**Exercise 3: Creating Text on a Path**

Now you will put text that you create on a motion path.

1. Create a new composition and add the media that you want to use as the background to the timeline. These exercises use a solid color, but you can use whatever you like.

2. Set the duration of the composition to three seconds.

3. Select the background layer in the timeline.


5. The Text window appears. Click in the window and type some text. The following examples show the phrase “See ya LATER...” However, you can use any text that you like.

6. Select the text and make any adjustments to the font, text color, shadow and fill properties. The examples in this exercise use the font Impact at 72 points, but you can use any font and size that you like.

7. When the text appears the way that you want, click Apply then close the Text window.

   Make sure that Text Wrap is set to No Wrap. This parameter is found in the Page tab in the Text window. By default it is set to No Wrap.

8. In the Effect Controls window, select the Composite on Original checkbox. When this is selected, the filter composites the text over the source layer. When this checkbox is deselected, the text is composited over an alpha channel. Layers in the timeline that are below the filtered layer are visible.
9. In the Effect Controls window, click the disclosure triangle to expand the Path parameter group.

10. Choose Circle from the Path Type menu. Use the Point 1 and Point 2 parameters to adjust the size of the circle. Point 1 sets the center point of the circular path. Point 2 sets the radius of the circle.

    The Comp window updates, showing the text wrapped around the Path.

11. Click the Stopwatch to create a keyframe for On Path Motion at the first frame of the layer. Set On Path Motion to 100.

12. Move the current-time marker to time 00:00:03:00 in the layer. Set On Path Motion to 1 X 2.00.

13. Preview the animation. The text now rotates twice around the circular path.

Exercise 4: Creating Text with a Backdrop

In this exercise you will create text with a backdrop using both the Vector Text and Vector Shape filters.

1. Create a new composition and add the media that you want to use as the background to the timeline. These exercises use a solid color, but you can use whatever you like.

2. Set the duration of the composition to four seconds.

3. Select the background layer in the timeline.

4. Choose Effect > Boris > Vector Text.

5. The Text window appears. Click in the window and type “Coming Soon.”

6. Make any adjustments to the font, text color, shadow and fill properties.
The illustrations in this exercise use the settings shown in the illustration at right: Denmark font at 60 points with blue Fill and a Solid Shadow. However, you can use whatever type of text you like.

7. When the text appears the way that you want, click Apply to close the Text window.

8. In the Effect Controls window, select the Composite on Original checkbox. When this is selected, the filter composites the text over the source layer. When this checkbox is deselected, the text is composited over an alpha channel. Layers in the timeline that are below the filtered layer are visible.

9. Select the background layer in the timeline.

10. Choose Effect > Boris > Vector Shape.

11. Make sure that the Vector Shape filter is above the Vector Text filter in the Effects Controls window.

12. Click the disclosure triangle to expand the Primitive Shape parameter group.

13. Choose the shape that you want from the Shape Primitive menu. The illustrations in this exercise use the Oval shape, but you can use whatever shape you like.

14. Adjust the Shape Left, Shape Top, Shape Right, and Shape Bottom parameters until the shape appears behind your text. These parameters set the positions of the corners of a rectangle in which the oval is inscribed. These values are scaled as percentages of the width and height of the Comp window.

The illustrations show Shape Left set to 5.00 and Shape Right to 95.00, but you can use whatever parameters you like.

15. Click the disclosure triangle to expand the Border 1 parameter group.

16. Leave the Border Type menu set to Bevel.
17. Use the Eyedropper tool to set the border Color to the same color as your text fill.

18. Click the disclosure triangle to expand the Shape Fill parameter group.

19. Click to deselect the Shape Fill checkbox.
   This creates an unfilled backdrop.

20. Preview your effect. Now you will animate the backdrop.

21. In the Border 1 parameter group, click the Stopwatch to create a keyframe for Border End at the first frame of the layer.

22. Move the current-time marker to time 00:00:01:00 in the layer. Set Border End to 100.
   The Border now animates on.

Exercise 5: Using Expressions to Animate Text and a Backdrop

Expressions can create a relationship between two properties. In this case you will use expressions to animate the Vector Text and the Vector Shape together.

1. Complete the steps in the previous sections, “Exercise 4: Creating Text with a Backdrop” on page 107.

2. Move the current-time marker to the first frame in the layer.

3. Click the disclosure triangle to expand the Transformations parameter group in the Vector Shape filter.

4. Click the Stopwatch to animate the Spin and PreRotate Position X/Y parameters.

5. Click the disclosure triangle to expand the Page Transformations parameter group in the Vector Text filter.

6. Click the Stopwatch to animate the Spin and PreRotate Position X/Y parameters.

7. Press the U key or choose Animation >Reveal Animating Properties.
8. In the Timeline window, select the Spin and PreRotate Position X/Y parameters for the Vector Shape.

9. Choose Animations > Add Expression.

10. Click the disclosure triangle next to Spin and drag the Pick Whip from the Spin parameter for the Vector Shape to the Spin parameter for the Vector Text. For information on the Pick Whip, see your After Effects documentation.

11. Click the disclosure triangle next to PreRotate Position X/Y and drag the Pick Whip from the PreRotate Position X/Y parameter for the Vector Shape to the PreRotate Position X/Y parameter for the Vector Text.

   The Spin and PreRotate Position X/Y parameters for the Vector Shape turn red in the timeline.

12. With the current-time marker at the first frame in the layer, set Spin (in the Vector Text) to 35 degrees.

13. Move the current-time marker to time 00:00:03:00 in the layer and create a new keyframe for the PreRotate Position X/Y parameter for the Vector Text by selecting the PreRotate Position X/Y and choosing Animation > Add Keyframe.

14. Move the current-time marker to time 00:00:04:00 in the layer and set PreRotate Position X/Y parameter for the Vector Text to 1200 x 243.

15. Preview the effect. The text and backdrop now animate out of frame for one second.

**Exercise 6: Creating a Text Scrambler Effect**

In this exercise you will create a random text effect using the Text Scrambler filter. The text will appear randomly scrambled, then it will reveal itself in an animated wave-like effect to be a familiar phrase.

1. Create a new composition and add the media that you want to use as the background to the timeline. These exercises use a solid black color, but you can use whatever you like.

2. Set the duration of the composition to four seconds.

3. Select the background layer in the timeline.


5. The Text window appears. Click in the window and type some text. The following examples show the phrase “the quick brown fox jumped over the lazy dog.” However, you can use any text that you like.

6. Select the text and make any adjustments to the font, text color, shadow and fill properties. The examples in this exercise use the font Courier New at 100 points, but you can use any font and size that you like.

7. When the text appears the way that you want, click Apply to close the Text window.
8. In the Effect Controls window, select the **Composite on Original checkbox**. When this is selected, the filter composites the text over the source layer. When this checkbox is deselected, the text is composited over an alpha channel. Layers in the timeline that are below the filtered layer are visible.

```
the quick brown fox jumps over the lazy dog
```

9. Move the current-time marker to the beginning of the timeline.

10. In the Page Transformations parameter group in the Effect controls window, adjust **Position X/Y** so that the text appears at the bottom third of the screen. Set **Master Scale** to 22. Set **Scale X** to 90.

11. In the Variations parameter group, click the Stopwatch to create a keyframe for **User Text Variation** at the first frame of the layer and set this to 14. When you adjust User Text Variation, each ASCII character value offsets by a certain amount. This includes spaces between words. When Letter Variation is 0, no variation occurs.

12. Choose **User Text** from the **Generator Type menu**. Choosing User Text allows you to type a phrase into the Text window for this effect.

13. Choose **Random Text** from the **Variation Mode menu**. Random Text uses alphabetical characters for the text randomization. The characters are randomized so that repeated letters in the original words are not necessarily the same.

14. Choose **Right to Left** from the **Progress Order menu**. Choosing this option will type the text on from right to left.

15. Move the current-time marker to 00:00:02:00 in the timeline.

16. In the Variations parameter group, click the Stopwatch to create a keyframe for **Progress** and set this parameter to 100. The Progress parameter allows you to control which characters change.

17. In the Type On parameter group, click the Stopwatch to create a keyframe for **Text Type On** and set this parameter to 0. Text Type On adjusts the percentage of the text that is visible in each frame.
18. In the Type On parameter group, enable the **Always Visible checkbox**. Selecting the Always Visible checkbox forces characters to remain visible while the transformations are progressively applied.

19. In the Type On parameter group, set **Reveal Time** to 1565, set **Fade** to 34, set **Shift Y** to -25, set **Scale X** to 143, set **Scale Y** to 415 and set **Rotate** to 4 degrees. These parameters transform the letters during the portion of the effect where the words are revealing themselves. You can only see their effects while Progress and Text Type On are animating.

20. Move the current-time marker to 00:00:03:00 in the timeline.

21. In the Variations parameter group, set **User Text Variation** to 100. Setting this parameter to 100 here stops it from animating until the end of the effect. Set **Progress** to 0. Setting this parameter to 0 stops any characters from changing until the end of the effect.

22. In the Type On parameter group, click the Stopwatch to create a keyframe for **Text Type On** and set this parameter to 100. Setting this parameter to 100 stops characters from typing on until the end of the effect.

23. Play the effect. The words reveal themselves in a wave-like effect.
24. Play the effect without the **Always Visible** parameter checked. Notice how the effect is changed and you cannot see all of the letters when they are not animating.